
Учреждение образования  
«БЕЛОРУССКИЙ ГОСУДАРСТВЕННЫЙ  
ТЕХНОЛОГИЧЕСКИЙ УНИВЕРСИТЕТ» 

 
 

 
 
 

 
АППАРАТНЫЕ И ПРОГРАММНЫЕ 

СРЕДСТВА ОЦЕНКИ НЕОДНОРОДНОСТИ 
ЦЕЛЛЮЛОЗНЫХ КОМПОЗИЦИОННЫХ 

МАТЕРИАЛОВ 
 

Рекомендовано 
учебно-методическим объединением по образованию 
в области природопользования и лесного хозяйства 

в качестве учебно-методического пособия для студентов 
учреждений высшего образования по специальности 

6-05-0711-03 «Технология и переработка биополимеров» 
и учебно-методическим объединением по химико-технологическому 

образованию в качестве учебно-методического пособия  
для студентов учреждений высшего образования по специальностям  

6-05-0714-07 «Печатные цифровые системы и комплексы», 
6-05-0722-06 «Принттехнологии» 

 
 
 

 
 

 
 
 
 

Минск 2025 



УДК 676.2.017:004.4(075.8)  
ББК 35.779:32.972я73 

   А76 
Авторы: 

М. А. Зильберглейт, С. К. Грудо, А. А. Коренькова, Н. П. Мидуков 
 

Рецензенты:  
кафедра «Промышленный дизайн и упаковка»  

Белорусского национального технического университета  
(кандидат технических наук, доцент, доцент кафедры Д. М. Медяк;  

доцент, заведующий кафедрой П. А. Кашевский);  
доктор технических наук, профессор, главный научный сотрудник 

ГНУ «Объединенный институт проблем информатики 
Национальной академии наук Беларуси» В. В. Старовойтов 

 
Все права на данное издание защищены. Воспроизведение всей книги 

или ее части не может быть осуществлено без разрешения учреждения обра-
зования «Белорусский государственный технологический университет». 
 

Аппаратные и программные средства оценки неоднород- 
А76 ности целлюлозных композиционных материалов : учеб.-ме-

тод. пособие для студентов специальностей 6-05-0711-03 «Техно-
логия и переработка биополимеров», 6-05-0714-07 «Печатные 
цифровые системы и комплексы», 6-05-0722-06 «Принттех-
нологии» / М. А. Зильберглейт, С. К. Грудо, А. А. Коренькова, 
Н. П. Мидуков. – Минск : БГТУ, 2025. – 89 с. 

ISBN 978-985-897-258-5.  
 
Учебно-методическое пособие посвящено актуальной методике ана-

лиза неоднородности целлюлозных композитов. В основе подхода лежат 
современные физические методы исследования, позволяющие детально 
изучать как внешние, так и внутренние характеристики материалов с по-
следующей визуализацией полученных данных. Материал пособия охваты-
вает весь спектр необходимых знаний: от фундаментальных аспектов обра-
ботки информации до конкретных практических решений. Особое внимание 
уделяется работе с современным оборудованием и программным обеспе-
чением для анализа изображений. Практическая ценность издания под-
тверждается наличием специальной главы, демонстрирующей методику 
оценки неоднородности на примере картонных материалов. 

  
УДК 676.2.017:004.4(075.8) 
ББК 35.779:32.972я73   

  
ISBN 978-985-897-258-5  © УО «Белорусский государственный 

технологический университет», 2025 
ISBN          © Зильберглейт М. А., Грудо С. К.,  

Коренькова А. А., Мидуков Н. П., 2025 



3 

ВВЕДЕНИЕ 
 

При анализе характеристик бумаги для печати часто исполь-
зуется термин «просвет» (ранее обозначаемый как «облачность»). 
Этот параметр описывает неравномерное распределение волокни-
стых компонентов в структуре бумаги или картона, которое стано-
вится видимым при так называемом донном освещении. Термин 
«просвет» можно найти в ГОСТ 19088–89 «Бумага и картон. Термины 
и определения», а также в ОСТ 29.42–98 «Термины и определения 
дефектов материалов и полуфабрикатов для печати». 

В этих документах описывается распределение компонентов бу-
маги, которое можно визуально оценить при проходящем свете, раз-
деляя его на равномерное, облачное и клочковатое. Требования к 
просвету бумаги формулируются абстрактно с указанием на необхо-
димость однородности просвета и его соответствия образцу, утвер-
жденному заказчиком. 

Наличие неконтролируемой облачности может привести к двум 
негативным явлениям: повышенной обрывности и низкому каче-
ству печати. Неравномерное распределение волокнистых матери-
алов в бумаге проявляется в наличии шероховатости поверхности, 
которое состоит в рассевании света и гетерогенности внутренней 
структуры, что обусловлено неравномерностью упаковки разнород-
ного волокна. 

Попытка решить первую проблему в виде оценки шероховатости 
(гладкости) при определении воздухопроницаемости между стандарт-
ной пластиной и образцом бумаги годится только для образцов, харак-
теризующихся резким отличием таких свойств. Особые неприятности 
заложены в интегральном характере этого показателя, который нивели-
рует характерные отличия. На этом фактически и заканчиваются ме-
тоды оценки неоднородности поверхности.  

Оценка неоднородности внутренней структуры бумаги путем 
исследования разброса значений показателей прочности характе-
ризуется тем же недостатком, так как визуальная структура бумаж-
ного образца не фиксируется. Попытка сузить область изучаемой 
поверхности наталкивается на внушительные материальные труд-
ности в виде значительных затрат, а также по-прежнему мы не мо-
жем получить никаких визуальных данных о структуре. Например, 
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при определении так называемой «нулевой разрывной длины» требу-
ется дорогое прецизионное оборудование. 

В качестве современного подхода к решению задач, связанных 
с оценкой неоднородности, применяется анализ этого показателя 
при помощи физических методов, которые исследуют в первую оче-
редь внешнюю и внутреннюю поверхность и позволяют фиксировать 
результаты в виде изображений. 

Использование современных методов обработки изображений 
в бумажной и полиграфической промышленности сопровождается 
трудностями в понимании таких подходов. Специалисты бумажной 
отрасли фактически не применяют данные методы, за исключением 
получившего распространение в последнее время сканирования по-
верхности или структуры бумажного листа с выводом конечного ре-
зультата и с его неясным толкованием. Полиграфисты и бумажники, 
работающие в печатной отрасли, сосредоточены на улучшении каче-
ства отпечатка и используют свои трактовки и свою терминологию, 
которые, по нашему мнению, далеки от сути поднятого вопроса. 

На основе вышеизложенного мы бы хотели сформировать твер-
дое понимание терминологии, а также некоторых, наиболее важных 
методов, используемых в обработке изображений. Эти методы рас-
смотрены в контексте улучшения изображений, что поможет яснее 
понять, какой эффект они оказывают на изображение. 
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ГЛАВА 1 

ОСНОВНЫЕ СВЕДЕНИЯ 
О ЦИФРОВОЙ ФИКСАЦИИ ИЗОБРАЖЕНИЙ 

Изображение можно определить как двумерную функцию (х, у), 
где х и у – координаты в пространстве (конкретно на плоскости), и 
значение которой в любой точке, задаваемой парой координат (х, у), 
называется интенсивностью или уровнем серого изображения в этой 
точке. Если величины х, у принимают конечное число дискретных 
значений, то говорят о цифровом изображении. Каждое число, пред-
ставляющее значение яркости изображения в определенном месте, 
называется элементом изображения или пикселем. Физически пиксель 
можно представить как минимальный элемент изображения квадрат-
ной или круглой формы, характеризующийся цветом и яркостью. 

С понятием «пиксель» связан термин «растр» или «растровое изо-
бражение», т. е. массив ячеек, на который разбивается изображение, 
и в каждой ячейке находится пиксель. Детализация изображения опре-
деляется числом пикселей. При этом детализация изображения не мо-
жет быть увеличена за счет увеличения масштаба. При увеличении 
масштаба пиксели превращаются в квадраты разной яркости (рис. 1). 

     
Рис. 1. Увеличение масштаба изображения, не улучшающее его качество 
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Цифровой обработкой изображений называется обработка 
цифровых изображений с помощью цифровых вычислительных ма-
шин (компьютеров). Заметим, что цифровое изображение состоит 
из конечного числа элементов, каждый из которых расположен в 
конкретном месте и принимает определенное значение. Эти элементы 
называются элементами изображения или, как уже выше упомина-
лось, пикселями. Чаще всего для элементов цифрового изображения 
используется последний термин. 

Зрение является наиболее совершенным из наших органов 
чувств, поэтому неудивительно, что зрительные образы играют 
важнейшую роль в человеческом восприятии. Однако, в отличие 
от людей, способных воспринимать электромагнитное излучение 
лишь в видимом диапазоне, машинная обработка изображений 
охватывает практически весь электромагнитный спектр от гамма-
излучения до радиоволн. Обрабатываемые изображения могут по-
рождаться такими источниками, которые для человека непривычно 
связывать с наблюдаемыми изображениями. Таковы, например, уль-
тразвуковые изображения; изображения, получаемые в электронной 
микроскопии или генерируемые компьютером. Таким образом, циф-
ровая обработка изображений охватывает широкие и разнообразные 
области применения. 

Не существует общепринятой точки зрения, где заканчивается 
обработка изображений и начинаются другие смежные области, 
например анализ изображений и машинное зрение. Иногда разграни-
чение делается здесь по тому принципу, что обработка изображений 
определяется как дисциплина, в которой на входе и на выходе про-
цесса присутствуют изображения. Исходя из вышеприведенного за-
мечания, мы видим, что естественным этапом перехода от обработки 
изображений к их анализу выступает распознавание отдельных обла-
стей или объектов на изображении. В качестве простой иллюстрации, 
разъясняющей указанные понятия, рассмотрим область автоматизи-
рованного анализа печатного или рукописного текста. В сферу циф-
ровой обработки изображений входят процессы получения изобра-
жения области, содержащей этот текст, предварительной обработки 
полученного изображения, выделения (сегментации) отдельных сим-
волов текста, описания символов в подходящей для компьютерной 
обработки форме и, наконец, распознавания этих символов. Что каса-
ется осмысления содержимого страницы, то оно может быть отнесено 
уже к сфере анализа изображений или даже машинного зрения, в за-
висимости от уровня сложности. 
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Одно из первых применений цифровых изображений было опро-
бовано в газетном деле для передачи иллюстраций по трансокеан-
скому подводному кабелю между Лондоном и Нью-Йорком. В начале 
1920-х гг. была внедрена система «Бартлейн» для передачи изображе-
ний по кабелю, что позволило уменьшить время доставки иллюстра-
ций через Атлантику с обычной недельной задержки до трехчасовой. 
С помощью специального печатающего оборудования осуществля-
лось кодирование исходного изображения для передачи по кабелю и 
последующее восстановление этого изображения на приемной стороне. 

Ряд начальных проблем, связанных с улучшением визуального 
качества этих первых цифровых изображений, относился к выбору 
процедуры печати и распределению уровней интенсивности. Способ 
печати, с помощью которого были получены первые изображения, 
был отвергнут в пользу технологии фотографической репродукции с 
использованием перфоленты, формируемой телеграфным аппаратом 
на приемной стороне линии. 

С 1960-х гг. до настоящего времени область применения обра-
ботки изображений значительно расширилась. Помимо медицинских 
и космических приложений, методы цифровой обработки изображе-
ний сегодня используются в широком спектре областей. Компьюте-
ризированные процедуры применяются для облегчения восприятия 
рентгеновских и иных изображений в промышленности, медицине и 
биологии путем повышения контраста или цветового кодирования 
различных уровней интенсивности (представления изображений в псев-
доцветах). Аналогичные методы используются в географии для изуче-
ния картины загрязнений окружающей среды по данным аэрофото-
съемки и космическим снимкам. Методы улучшения и восстановления 
изображений применяются при обработке некачественных изображе-
ний утраченных объектов или трудновоспроизводимых эксперимен-
тальных результатов. Например, в археологии с помощью методов 
цифровой обработки изображений удалось по имеющимся нечетким 
фотографиям успешно восстановить первоначальный вид раритетов, 
которые со времени съемки были утрачены или повреждены. В фи-
зике и смежных областях компьютерная обработка является обыч-
ным способом улучшения качества изображений, получаемых в ходе 
экспериментов, как, например, в электронной микроскопии или фи-
зике высокотемпературной плазмы. Аналогичные примеры успеш-
ного использования технологий обработки изображений можно 
найти в астрономии, биологии, медицинской радиологии, промыш-
ленности, оборонной и правоохранительной сфере. 
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Приведенные примеры относились к случаям, когда результаты 
обработки предназначены для восприятия человеком. Другая круп-
ная область применения методов обработки изображений – это ре-
шение задач, связанных с машинным восприятием изображений. 
В этом случае в центре внимания находятся процедуры, которые из-
влекают из изображения некоторую информацию и представляют 
ее в форме, подходящей для компьютерной обработки. Часто эта ин-
формация весьма мало похожа на визуальные признаки, используе-
мые людьми при интерпретации содержимого изображения. Приме-
рами информации такого рода, часто применяемой при машинном 
восприятии изображений, могут быть различные математические ме-
тоды обработки (например, статистические моменты (дисперсия), ко-
эффициенты преобразования Фурье, значения многомерного рассто-
яния и др.). Типичными задачами машинного восприятия, в которых 
интенсивно используются методы обработки изображений, являются 
автоматическое распознавание символов, системы машинного зрения 
для автоматизации сборки и контроля продукции, задачи опознава-
ния «свой – чужой» для военных объектов, автоматическая обработка 
отпечатков пальцев, проверка анализов крови и результатов рент-
геновских исследований, компьютерная обработка аэрофотоснимков 
и спутниковых изображений с целью прогнозирования погоды и эко-
логического мониторинга. 
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ГЛАВА 2 

ОСНОВНЫЕ СТАДИИ ЦИФРОВОЙ 
ОБРАБОТКИ ИЗОБРАЖЕНИЙ 

Регистрация изображения осуществляется различными физи-
ческими методами, использующими гамма-лучи, рентгеновские лучи, 
ультрафиолетовый, видимый, инфракрасный диапазоны, микровол-
новой диапазон, диапазон радиоволн. 

Из всего спектра человеческий глаз способен улавливать из-
лучение только в очень узком диапазоне видимого света. От одного 
его края до другого частота излучения (а равно длина волны и энер-
гия квантов) меняется менее чем в 2 раза. Для сравнения самые длин-
ные радиоволны в 1014 раз длиннее видимого излучения, а самые 
энергичные гамма-кванты – в 1020 раз. Тем не менее на протяжении 
многих тысяч лет большую часть информации об окружающем мире 
люди черпали из диапазона видимого излучения, границы которого 
определяются свойствами светочувствительных клеток человеческой 
сетчатки. 

Разные длины волн видимого света воспринимаются человеком 
как разные цвета – от красного до фиолетового. Традиционное деле-
ние видимого диапазона спектра на семь цветов радуги является куль-
турной условностью. Никаких четких физических границ между 
цветами нет. Англичане, например, обычно делят радугу на шесть 
цветов. Известны и другие варианты. За восприятие всего разнообра-
зия цветов и оттенков видимого света отвечают всего три различных 
типа рецепторов, которые чувствительны к красному, зеленому и си-
нему цвету. Это позволяет воспроизводить практически любой цвет, 
смешивая на экране эти три основных цвета. 

Отправляясь от видимого света в длинноволновую сторону спек-
тра, мы попадаем в диапазон инфракрасного (ИК) излучения. Ближ-
нее ИК-излучение физически ничем не отличается от видимого све-
та, за исключением того, что не воспринимается сетчаткой глаза. 
Его можно регистрировать теми же приборами, в частности, специа-
лизированными микроскопами, что и видимый свет. К инфракрасному 
диапазону примыкает радиоизлучение, которое охватывает весь длин-
новолновый край электромагнитного спектра. 
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С коротковолновой стороны от видимого света располагается 
ультрафиолетовый диапазон, который делят на ближний и вакуум-
ный. Органами чувств человек его не воспринимает. Формальной 
границы между жестким ультрафиолетовым и рентгеновским излу-
чением нет. К рентгену принято относить излучение, способное вы-
зывать возбуждение атомных ядер – подобно тому, как видимое и ин-
фракрасное излучение возбуждает электронные оболочки атомов и 
молекул. В этом случае даже жесткий вакуумный ультрафиолет в не-
которых случаях может быть отнесен к рентгену. Граница, на которой 
рентгеновский диапазон сменяется гамма-излучением, также условна. 

Рассмотрим некоторые конкретные приемы регистрации неодно-
родных объектов (бумага, картон). 

Ультразвуковые методы используют звуковые волны, имеющие 
частоты обычно в диапазоне мегагерц (МГц). Звуковая волна, про-
ходя через материал, теряет энергию, когда сталкивается с дефектом. 
Ультразвуковые волны способны проникать в материалы, что позво-
ляет изучать микроструктуру материалов, обнаруживать небольшие 
дефекты, исследовать межфазные переходы, а также получать ин-
формацию о механических свойствах. Две основные ультразвуковые 
техники – это метод проходящей волны и метод импульсного эха. 
Наиболее часто используемыми типами волн в неразрушающем кон-
троле (НК) являются продольные и сдвиговые волны. Эти волны 
служат для определения толщины материалов и покрытий, а также 
для оценки материалов по отношению к дефектам, микрострукту-
рам и остаточным напряжениям. Ультразвуковые методы также при-
меняются для оценки отделений и расслоений в различных материа-
лах. Для характеристики поверхностных дефектов используются 
поверхностные волны Рэлея и волны Лэмба. Поверхностные волны 
можно использовать для оценки качества соединений. Метод обрат-
ного рассеяния ультразвука применяется для характеристики по-
верхностных слоев в случае закаленных компонентов. Для оценки 
размера зерен в поверхностных зонах используются моды поверх-
ностных волн с такими параметрами, как амплитуда обратнорассеян-
ной утечки волны Рэлея и амплитуда поверхностной волны Рэлея. 

На основании достижений в электронике и лазерах в последнее 
время было разработано несколько методов ультразвуковой визуа-
лизации. Здесь обсуждаются два метода микроскопии, которые ис-
пользуют ультразвуковые волны с частотами примерно от 10 МГц 
до 2 ГГц, а именно: сканирующая акустическая микроскопия (SAM) 
и сканирующая лазерная акустическая микроскопия (SLAM). 



11 

В системе SAM применяется сфокусированный ультразвуковой 
луч для получения изображения аналогично оптическому микро-
скопу. Волна, генерируемая ультразвуковым преобразователем, 
фокусируется акустической линзой, а затем частично отражается 
от объекта. Амплитуда и/или фаза возвращающихся звуковых волн 
измеряются. Если расстояние между линзой и объектом поддержива-
ется в фокусе, а амплитуда возвращающейся звуковой волны записы-
вается как функция координат поверхности объекта, получается аку-
стическое изображение поверхности объекта. 

Принцип работы сканирующего лазерного акустического микро-
скопа состоит в том, что образец обрабатывается импульсным звуком 
под углом относительно поверхности образца. Ультразвук вызывает 
динамическую рябь противоположной поверхности в однородном об-
разце, от которой отражается лазерный луч и направляется на фото-
диод. Рябь приводит к частичному дифракционному отклонению и ча-
стотному смещению лазерного луча, которое демодулируется методом 
клинового детектора. Амплитуда переменного компонента в фотодиоде 
пропорциональна амплитуде ряби. Ультразвуковая волна рассеива-
ется и отражается порами, включениями, трещинами и разрывом связи, 
которые, в свою очередь, становятся видимыми как модуляция ра- 
нее гомогенной поверхности ряби. Сканированием лазерным лучом 
по образцу эти модуляции отображаются на компьютере. Разрешение 
таких изображений задается длиной волны λ ультразвука и обычно со-
ставляет 50 мкм. Измеряя как амплитуду, так и фазу этого голографи-
ческого акустического поля, можно восстановить геометрию дефекта. 

Лазерные методы используются как часть процедуры квалифи-
кации и также для оценки изменения качества поверхности. Одним 
из наиболее широко применяемых методов является метод лазерного 
рассеяния. Он предназначен для оценки шероховатости поверхно-
сти, повреждения от усталости, дефектов в модифицированных по-
верхностных покрытиях/слоях и для обнаружения трещины/дефекта 
склейки в композитах. В этом методе лазерный луч от гелий-неоно-
вого лазера направляется на образец, поверхность которого подлежит 
оценке. Рассеянное излучение попадает на полупрозрачный экран, 
расположенный на расстоянии 600 мм от образца. Экран помещается 
перпендикулярно направлению зеркального отражения луча. Камера 
с зарядовой связью (CCD), подключенная к компьютеру через карту 
захвата изображения, располагается позади экрана вдоль направле-
ния зеркального отражения. Параметры лазерного рассеяния, такие 
как высота пика и полная ширина на уровне половины максимума, 
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используются для оценки характеристик поверхности. С помощью 
метода лазерного рассеяния определяются вариации порядка 25 мк. 

Методы атомно-силовой микроскопии. Методы для оценки шеро-
ховатости на поверхности твердых тел, основанные либо на механиче-
ском контакте, либо на оптических бесконтактных датчиках, приме-
нимы также для покрытий и слоев. Атомно-силовой микроскоп (АСМ) 
является последним достижением в этой области. Рабочий принцип 
АСМ следующий. Кантилевер, чрезвычайно чувствительный к слабым 
силам, фиксируется с одного конца, а другой конец имеет острый нако-
нечник, который слегка касается поверхности образца. Когда поверх-
ность сканируется, из-за ультрамалых сил отталкивания между ато-
мами кончика и атомами поверхности образца кантилевер будет 
двигаться вверх и вниз в направлении, перпендикулярном поверхности 
образца. Топографические изображения получаются путем записи от-
клонений кантилевера, соответствующих контурам силы взаимодей-
ствия между кончиком и атомами поверхности образца. АСМ при-
меняется для измерения шероховатости поверхности в небольших 
областях (менее 100 мкм) с контактом и без него. 

Гамма-лучи. В этом случае используется радиоактивный изотоп, 
распад которого сопровождается гамма-излучением. Это излучение 
регистрируется детекторами гамма-излучения, сигналы которых и 
служат для формирования изображения. 

Рентгеновские лучи – один из самых старых источников электро-
магнитного излучения, используемых для получения изображений. Хо-
рошо известно применение рентгеновских лучей для медицинской диа-
гностики, однако они также широко используются в промышленности 
и других областях. Рентгеновское излучение для формирования изоб-
ражений генерируется с помощью рентгеновской трубки – вакуумного 
прибора с катодом и анодом. Катод находится в нагретом состоянии, 
вследствие чего испускает свободные электроны, которые с высокой 
скоростью летят к положительно заряженному аноду. При соударении 
электронов с ядрами атомов материала анода энергия выделяется в 
форме рентгеновского излучения. Энергия рентгеновских лучей (часто 
называемая «жесткостью»), определяющая их проникающую способ-
ность, регулируется изменением приложенного к аноду напряжения, а 
интенсивность излучения (количество рентгеновских лучей) регулиру-
ется изменением тока, проходящего через нить накала катода. 

Изображение в видимом свете получают с помощью оптического 
микроскопа. Диапазон примеров простирается от фармацевтики и 
микроскопических методов производственного контроля до опреде-
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ления характеристик материалов. Даже в пределах одной микроско-
пии множество возможных прикладных областей слишком обширно, 
чтобы его детально описать. 

Интересным оборудованием для исследования бумаги являются 
сканеры, предназначенные для оцифровки фотопленки. Стандартный 
размер (это обычно 24 на 36 мм) позволяет осуществить достаточно 
широкий охват, а также по нашему опыту производить просвечива-
ние за приемлемое время с разрешением до 4800 dpi. 

Электронный микроскоп действует аналогично оптическому с той 
разницей, что вместо световых лучей для получения изображения ис-
следуемого объекта применяется сфокусированный пучок электронов. 
Работа электронного микроскопа складывается из следующих основ-
ных шагов. Источник испускает поток электронов, которые благодаря 
приложенному положительному напряжению движутся с ускорением 
в направлении исследуемого образца. С помощью металлических ще-
левых диафрагм и магнитных линз этот поток ограничивается и фоку-
сируется, образуя тонкий пучок, сфокусированный на образце. Внутри 
облучаемого образца происходит взаимодействие, оказывающее вли-
яние на прохождение пучка электронов, эффект от которого обнару-
живается и преобразуется в изображение аналогично тому, как свет 
отражается или поглощается объектами наблюдаемой сцены.  

Перечисленные основные шаги имеют место во всех электрон-
ных микроскопах независимо от их типа. 

Принцип работы просвечивающего электронного микроскопа (ПЭМ) 
во многом аналогичен проектору слайдов. Проектор направляет (пе-
редает) пучок света на слайд; при проходе этого пучка сквозь слайд 
свет модулируется содержимым слайда. После этого пучок света 
проецируется на экран, формируя увеличенное изображение слайда. 
ПЭМ работает точно так же, за исключением того, что сквозь обра-
зец, играющий роль слайда, направляется пучок электронов. 

Сканирующий (растровый) электронный микроскоп (СЭМ или РЭМ) 
осуществляет действительное сканирование образца электронным пуч-
ком и запись отраженного результата взаимодействия электронного пучка 
с каждой точкой поверхности образца. Полное изображение формиру-
ется путем растрового сканирования образца электронным пучком ана-
логично телевизионной развертке. Отраженные электроны при попада-
нии на фосфоресцирующий экран создают на нем видимое изображение. 

Улучшение изображения входит в число наиболее простых обла-
стей цифровой обработки изображений. По существу, за методами улуч-
шения изображений стоит идея выявления плохо различимых деталей 
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или просто подчеркивания интересующих характеристик на исход-
ном изображении. Известным примером улучшения является усиле-
ние контраста изображения, потому что в результате «оно выглядит 
лучше». Важно иметь в виду, что улучшение качества – весьма субъ-
ективная область в обработке изображений. 

Восстановление изображений – это область, также связанная с по-
вышением визуального качества изображения, однако, в отличие от соб-
ственно улучшения, критерии которого субъективны, восстановление 
изображения является объективным в том смысле, что методы восстанов-
ления изображений опираются на математические или вероятностные мо-
дели искажений изображения. Напротив, улучшение изображений осно-
вано на субъективных предпочтениях человеческого восприятия, которые 
связаны с тем, что именно считается «хорошим» результатом улучшения. 

Обработка цветных изображений приобрела особую важность 
в связи со значительным расширением использования цветных изоб-
ражений в технологических областях. 

Сжатие, как следует из самого названия, относится к методам 
уменьшения объема памяти, необходимого для хранения изображения, 
или сужения полосы пропускания канала, требуемой для его передачи. 

Морфологическая обработка связана с инструментами для из-
влечения таких компонент изображения, которые могут быть полезны 
для представления и описания формы. 

Сегментация разделяет изображение на составные части или объ-
екты. В целом автоматическая сегментация принадлежит к числу самых 
трудных задач цифровой обработки изображений. С одной стороны, 
излишне подробная сегментация уводит процесс решения задачи об-
работки изображения на сложный путь, если требуется идентифи-
цировать объекты по отдельности. С другой стороны, недостаточно 
подробная или же ошибочная сегментация почти неизбежно приведет 
к возникновению ошибок на финальной стадии обработки. В общем, 
чем точнее сегментация, тем больше шансов на успех при распознавании. 

Распознавание образов (изображений) – это процесс отнесения 
исходных данных к определенному классу с помощью выделения су-
щественных признаков, характеризующих эти данные. 

Несмотря на многочисленные возможные способы регистрации 
изображений, задача обработки всегда одна и та же: сформировать циф-
ровое изображение на основе данных, воспринимаемых чувствитель-
ными элементами. От большинства сенсоров поступает аналоговый вы-
ходной сигнал в форме непрерывно меняющегося напряжения, форма 
и амплитуда которого связаны с регистрируемым физическим явлением. 
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Чтобы получить цифровое изображение, необходимо преобразо-
вать непрерывно поступающий сигнал в цифровую форму. Эта опе-
рация включает в себя два процесса – дискретизацию и квантование. 

Дискретизация – это преобразование непрерывного сигнала в 
последовательность чисел (отсчетов).  

Квантова́ние (англ. quantization) – разбиение диапазона отсчетных 
значений сигнала на конечное число уровней и округление этих зна-
чений до одного из двух ближайших к ним уровней. При этом значение 
сигнала может округляться либо до ближайшего уровня, либо до мень-
шего или большего из ближайших уровней в зависимости от способа 
кодирования (рис. 2). 

 
Рис. 2. Преобразование аналогового сигнала в цифровой: 

а – аналоговый сигнал; б – дискретный по времени  
и аналоговый по амплитуде сигнал;  

в – дискретный по времени  
и квантованный по амплитуде сигнал  

(горизонтальные линии на сетке – уровни квантования;  
вертикальные – моменты взятия отсчетов) 
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В случае регистрации изображения по обоим направлениям дис-
кретизация и квантование выглядят следующим образом (рис. 3). 

В результате операций дискретизации и квантования возникает 
матрица действительных чисел. В данном случае используется основ-
ной способ представления цифровых изображений. Предположим, что в 
результате дискретизации изображения (х, у) получена матрица из 
М строк и V столбцов. Координаты (х, у) становятся теперь дискрет-
ными значениями. Для ясности обозначений и большего удобства мы 
будем применять для этих дискретных координат целочисленные 
значения, принимая за начало координат левый верхний угол изобра-
жения, где (х, у) = (0, 0). Следующим значением координат вдоль пер-
вой строки изображения будет точка (х, у) = (0, 1). Важно иметь в виду, 
что обозначение (0, 1) используется лишь для указания на второй от-
счет в первой строке и не означает, что это фактические значения фи-
зических координат точек дискретизации. 

 

 
  а    б 

Рис. 3. Результат дискретизации (а) и квантования (б) 
 
Яркостным (или полутоновым) разрешением называется мель-

чайшее различимое изменение яркости, но процесс измерения разли-
чимых уровней яркости является субъективным. Если при дискрети-
зации изображений имеется относительно большая свобода действий 
при выборе числа отсчетов (т. е. частоты дискретизации), то при уста-
новлении числа градаций яркости приходится в значительной сте-
пени учитывать особенности аппаратуры; по этим причинам число 
градаций обычно выбирается равным степени 2. Наиболее частым ре-
шением является выбор 8-битного представления (256 градаций яр-
кости), но в некоторых приложениях используется 16 бит, если необ-
ходимо иметь более точное представление полутонов.  
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ГЛАВА 3 

БИНАРНЫЕ ИЗОБРАЖЕНИЯ 

Поскольку изображения содержат большой объем информации, 
важную роль начинают играть вопросы ее представления. Покажем, 
что интересующие нас геометрические характеристики можно из-
влечь из проекций бинарных изображений. Проекции гораздо легче 
хранить и обрабатывать. Также рассмотрим непрерывные бинарные 
изображения, характеристическая функция которых равна нулю или 
единице в каждой точке плоскости изображения. Это упрощает ана-
лиз, однако при использовании ЭВМ изображение необходимо раз-
бить на дискретные элементы. 

Начнем со случая, когда в поле зрения находится объект, а все 
остальное считается фоном. Если объект оказывается заметно темнее 
(или светлее), чем фон, то легко определить функцию b(x, y), которая 
называется характеристической и которая равна нулю для всех точек 
изображения, соответствующих фону, и единице для точек на объ-
екте или наоборот. 

Поскольку количество информации, содержащейся в бинарном 
изображении, на порядок меньше, чем в совпадающем с ним по раз-
мерам полутоновом изображении, бинарное изображение легче об-
рабатывать, хранить и пересылать. Естественно, определенная часть 
информации при переходе к бинарным изображениям теряется, и, 
кроме того, сужается круг методов обработки таких изображений. 
В настоящее время существует достаточно полная теория того, 
что можно и чего нельзя делать с бинарными изображениями, чего, к 
сожалению, нельзя сказать о полутоновых изображениях. 

Как определить положение объекта на изображении? Поскольку 
объект, как правило, состоит не из одной-единственной точки, мы 
должны четко определить смысл термина «положение». Обычно в каче-
стве характерной точки объекта выбирают его геометрический центр.  

Геометрический центр – это центр масс однородной фигуры 
той же формы. Данный термин подробно рассмотрен в курсе теоре-
тической механики. В свою очередь центр масс определяется точкой, 
в которой можно сконцентрировать всю массу объекта без измене-
ния его первого момента относительно любой оси. Более понятной 
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интерпретацией является представление о том, что вы имеете однород-
ный металлический лист неправильной формы и вы находите точку, 
установив на которую упор, лист будет находиться в равновесии. 

Мы также хотим определить, как расположен объект в поле зре-
ния, т. е. его ориентацию. Сделать это несколько сложнее. Допустим, 
что объект немного вытянут вдоль некоторой оси; тогда ее ориента-
цию можно принять за ориентацию объекта. Как точно определить 
ось, вдоль которой вытянут объект? Обычно выбирают ось мини-
мального второго момента. Она представляет собой двумерный ана-
лог оси наименьшей инерции. Для этого воспользуемся следующим 
утверждением. В любом теле существуют три взаимно перпендику-
лярные свободные оси, которые пересекаются в центре масс. В об-
щем случае момент инерции относительно одной из них максималь-
ный, относительно другой – минимальный, а относительно третьей 
имеет промежуточное значение. 

Можно показать, что в качестве очень грубого эмпирического 
правила можно считать, что минимальное пространственное и яр-
костное разрешение, при котором цифровое изображение будет отно-
сительно свободным от дефектов типа ложных контуров и ступенча-
тости, составляет около 256×256 пикселей с 64 градациями яркости. 

Обсуждение операций дискретизации и квантования изображе-
ний закончим кратким рассмотрением способов увеличения и умень-
шения цифровых изображений. Эта тема связана с дискретизацией и 
квантованием, поскольку увеличение может рассматриваться как по-
вышение частоты дискретизации, а уменьшение – как понижение 
этой частоты. Главное отличие обсуждаемых операций от дискрети-
зации и квантования исходного непрерывного изображения состоит 
в том, что они применяются к цифровому, т. е. ранее уже дискретизи-
рованному изображению. 

Для увеличения необходимы два шага: создание новой матрицы 
пикселей и затем присвоение этим новым пикселям определенных зна-
чений яркости. Начнем с простого примера. Предположим, что име-
ется изображение размером 500×500 пикселей, которое мы хотим 
увеличить в 1,5 раза, до размеров 750×750 пикселей. По идее, про-
стейший способ визуально наблюдать увеличение – это наложить 
на исходное изображение воображаемую сетку размером 750×750 эле-
ментов. Очевидно, что шаг сетки будет меньше одного пикселя ис-
ходного изображения. Чтобы присвоить значение яркости любому 
элементу наложенного изображения, найдем ближайший к нему 
пиксель исходного изображения и припишем его яркость данному 
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элементу сетки. Проделав аналогичную операцию для всех элементов 
сетки, получим искомое увеличенное изображение. Такой способ 
присвоения значений яркости называется интерполяцией по ближай-
шему соседу. Хотя увеличение с интерполяцией по ближайшему со-
седу выполняется быстро, оно имеет ту нежелательную особенность, 
что может приводить к заметной ступенчатости.  

Немного более сложным способом присвоения яркостей элемен-
там увеличенного изображения является билинейная интерполяция, 
в которой используются четыре ближайших соседа данной точки. 

Уменьшение изображений осуществляется способами, аналогич-
ными вышеизложенным для увеличения, но вместо операции дубли-
рования строк и столбцов пикселей используются операции выбра-
сывания строк и столбцов. Например, для уменьшения изображения 
в 2 раза выбрасываются строки и столбцы через один. Для иллюстра-
ции принципов уменьшения изображения в нецелое число раз мы мо-
жем воспользоваться той же аналогией с наложенной на исходное 
изображение сеткой, но с той лишь разницей, что шаг сетки теперь 
оказывается больше размера исходного пикселя. Для назначения яр-
кости элементам уменьшенного изображения применяются те же ме-
тоды, а именно интерполяция по ближайшему соседу или билинейная 
интерполяция.  
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ГЛАВА 4 

МЕТОДЫ УЛУЧШЕНИЯ ИЗОБРАЖЕНИЙ 

Множество подходов к улучшению изображений распадается на две 
большие категории: методы обработки в пространственной области (про-
странственные методы) и методы обработки в частотной области (ча-
стотные методы). Термин «пространственная область» относится к плос-
кости изображения как таковой, и данная категория объединяет 
подходы, основанные на прямом манипулировании пикселями изобра-
жения. Методы обработки в частотной области основываются на моди-
фикации сигнала, формируемого путем применения к изображению пре-
образования Фурье. Возможна также и комбинация этих двух подходов. 

Общей теории улучшения изображений не существует. Когда изоб-
ражение обрабатывается для визуальной интерпретации, наблюдатель 
является окончательным судьей того, насколько хорошо действует кон-
кретный метод. Визуальное оценивание качества изображения есть 
крайне субъективный процесс, делающий тем самым понятие «хорошего 
изображения» некоторым неуловимым эталоном, с помощью которого 
необходимо сравнивать эффективность алгоритма. Когда целью явля-
ется обработка изображения для машинного восприятия, задача оцени-
вания несколько проще. Например, в задаче распознавания символов 
наилучшим (оставляя в стороне другие вопросы, такие как вычислитель-
ные требования) будет тот метод обработки изображений, который дает 
более точные результаты машинного распознавания. Тем не менее даже 
в ситуации, когда задача позволяет установить четкие критерии каче-
ства, обычно требуется определенное количество попыток тестирова-
ния, пока будет выбран конкретный подход к улучшению изображений. 

Процессы пространственной обработки описываются уравнением 
 ( , ) [ ( , )],g x y T f x y=  (1) 

где g(х, у) – обработанное изображение; T – оператор над f, определен-
ный в некоторой окрестности точки (х, у); f(x, y) – входное изображение. 

На рис. 4 показана основная идея пространственного преобра-
зования. Точка входного изображения помещается в квадратную 
или прямоугольную матрицу. Передвижение этой матрицы осуще-
ствляется, как показано, справа налево, и при этом происходит изме-
нение яркости пикселя согласно оператору Т. 



21 

 
Рис. 4. Окрестность 3×3 вокруг точки (х, у) изображения 

 
Рассмотрим простой пример. Эффект преобразования заключа-

ется в получении изображения более высокого контраста по срав-
нению с оригиналом, для этого затемняют пиксели со значениями, 
меньшими т, и повышении яркостей пикселей со значениями, боль-
шими т на исходном изображении. 

Оператор может иметь такой вид, который в предельном случае 
дает в результате двухградационное (бинарное) изображение. 

Представленный пример относится к так называемым градацион-
ным преобразованиям, при помощи которых могут быть построены 
некоторые довольно простые, но действенные методы обработки изоб-
ражений. Поскольку результат улучшения каждого элемента изобра-
жения зависит только от яркости этого же элемента, методы данной 
категории часто относят к процедурам поэлементной обработки.  

Для практических целей вводится понятие так называемых ма-
сок, также упоминаемых в литературе как фильтры, ядра, шаблоны 
или окна. Чаще всего маска представляет собой небольшой (ска-
жем, 3×3 элемента) двумерный массив, который накладывается 
на изображение, и при этом осуществляется умножение элементов 
маски фильтра и соответствующих элементов изображения с после-
дующей обработкой результата в виде вывода нового изображения. 

Сглаживающие пространственные фильтры. Сглаживающие 
фильтры используются для расфокусировки (размытия) изображения 
и подавления шума. Расфокусировка может применяться как предва-
рительный шаг обработки изображения, например, для удаления мелких 
деталей перед обнаружением больших объектов либо же для устра-
нения разрывов в линиях или деталях. При этом интенсивность 

Начало 
координат 

(x, y) 

ƒ(x, y) 
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мелких объектов смешивается с фоном, в то время как большие объ-
екты остаются в виде пятен и могут быть легко обнаружены (рис. 5).  

Для подавления шумов может использоваться расфокусировка 
с применением как линейной, так и нелинейной фильтрации. 

Выход (отклик) простейшего линейного сглаживающего простран-
ственного фильтра есть среднее значение элементов по окрестности, 
покрытой маской фильтра. Такие фильтры иногда называют усредня-
ющими. Главное использование сглаживающих фильтров состоит в 
подавлении «несущественных» деталей на изображении. Под «несу-
щественными» здесь понимаются совокупности пикселей, которые 
малы по сравнению с размерами маски фильтра. 

Следует подчеркнуть, что на практике иногда достаточно трудно 
заметить разницу между изображениями, сглаженными разными 
фильтрами или какими-то другими, аналогичными по конструкции 
фильтрами, поскольку размеры области, покрываемые маской 
при фильтрации одного элемента, очень малы. 

Нелинейная фильтрация сводится к замещению исходного значе-
ния пикселя (в центре маски) на полученное значение отклика фильтра. 
Наиболее известен медианный фильтр, который, как следует из названия, 
заменяет значение пикселя значением медианы распределения яркостей 
всех пикселей в окрестности (включая и исходный). Медианные филь-
тры весьма популярны потому, что для определенных типов случайных 
шумов они демонстрируют отличные возможности подавления шума 
при значительно меньшем эффекте расфокусировки, чем у линейных 
сглаживающих фильтров с аналогичными размерами. В частности, 
медианные фильтры эффективны при фильтрации импульсных шумов, 
иногда называемых шумами «соль и перец», которые выглядят как на-
ложение на изображение случайных черных и белых точек. Вы увидите 
такую опцию при подробном рассмотрении программы ImageJ. 

 

 
Рис. 5. Пример расфокусировки 
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В этой же программе вы обнаружите фильтры, которые полезны 
при поиске на изображении наиболее ярких точек по отношению к 
окружающему фону. 

Пространственные фильтры повышения резкости необходимы, 
чтобы подчеркнуть мелкие детали изображения или улучшить те де-
тали, которые оказались расфокусированы вследствие ошибок или не-
совершенства самого метода съемки. 

Ранее было показано, что расфокусировка изображения может 
быть достигнута пространственной операцией усреднения значений 
точек по окрестности. Поскольку усреднение аналогично интегриро-
ванию, то логично прийти к выводу, что повышение резкости, будучи 
явлением, обратным по отношению к расфокусировке, может быть 
достигнуто пространственным дифференцированием.  

Поскольку изображение – по сути, дискретная функция, то про-
изводные дискретной функции определяются в терминах разностей. 
Эти разности можно задать различными способами, однако мы будем 
руководствоваться следующим. Первая производная должна быть:  

1) равной нулю на плоских участках (областях с постоянным уров-
нем яркости);  

2) ненулевой в начале и в конце ступеньки или склона яркости;  
3) ненулевой на склонах яркости.  
Аналогично вторая производная должна быть: 
– равной нулю на плоских участках; 
– ненулевой в начале и в конце ступеньки или склона яркости; 
– равной нулю на склонах постоянной крутизны. 
Пропуская математическую часть вопроса, которая связана с опера-

тором Лапласа (∇2), мы, тем не менее, отметим, что оператор Лапласа 
можно представить как меру «кривизны» функции. Если значение функ-
ции в точке выше среднего, это может указывать на «выпуклость», а 
если ниже – на «вогнутость». Далее продемонстрируем соответству-
ющее выражение, которое хотя бы внешним видом поясняет сказанное: 

 
2

2

( , ) ( , ),  если (0, 0) 0,  
( , )

( , ) ( , ),  если (0, 0) 0,
f x y f x y w

g x y
f x y f x y w

 − ∇ <= 
+ ∇ ≥

 (2) 

где w(0, 0) – значение центрального коэффициента маски лапласиана. 
Реальное воплощение этого приема вы увидите в одном из плагинов 
ImageJ под названием Mexican Hat. 

Приведем еще один пример, известный из фотографии, где для 
получения более резкого отпечатка на негатив накладывался 
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расфокусированный позитив, и экспозиция осуществлялась через по-
лученный двухслойный оригинал. Процедура была перенесена в поли-
графию и много лет используется в данной отрасли для повышения 
резкости изображений и заключается в вычитании из изображения 
его расфокусированной копии. Эта процедура, называемая нерезким 
маскированием, выражается формулой 

 ( , ) ( , ) ( , ),sf x y f x y f x y= −  (3) 

где fs(х, у) обозначает изображение с повышенной резкостью, полу-
ченное нерезким маскированием; ̅f (x, y) – расфокусированная копия 
исходного изображения f(х, у). 

Частотные методы обработки изображений базируются на преобра-
зовании Фурье. Хотя в технических учреждениях высшего образования 
изучают ряды Фурье и иногда и преобразование Фурье, связь между изоб-
ражением и этими понятиями часто остается чистой абстракцией. По-
этому напомним, что понятие ряда Фурье заключается в том, что любая 
функция, периодически воспроизводящая свои значения, может быть 
представлена в виде суммы синусов и/или косинусов различных частот, 
умноженных на некоторые коэффициенты. Сложность поведения функ-
ции при этом не имеет значения. Итак, если только функция является 
периодической и удовлетворяет некоторым математическим условиям, 
она может быть представлена в виде вышеуказанной суммы (рис. 6). 

 

 
Рис. 6. Графическая иллюстрация ряда Фурье.  

Нижняя функция – сумма четырех  
расположенных над ней функций 
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Важным практическим выводом из ряда Фурье следует, что, до-
бавляя, а самое главное, удаляя некоторые составляющие из триго-
нометрической суммы, можно влиять на вид одномерной суммарной 
кривой. Если некоторые виды колебаний являются «паразитными», 
можно «очистить» результирующую кривую. Для практической ре-
ализации такого подхода служат Фурье-преобразования. 

В Фурье-преобразовании используется понятие «спектр». Пояс-
ним на популярном примере. Рассмотрим синусоидальную функ-
цию, которая описывает гармоническое колебание. Общая форма та-
кой функции выглядит следующим образом: 
 y(t) = Asin(2πft + ϕ),  (4) 
где A – амплитуда (максимальное значение колебания); f – частота 
(количество колебаний в секунду); t – время; ϕ – фаза (начальное 
смещение). 

Когда мы применяем преобразование Фурье к этой функции, 
то получаем спектр частот, который показывает, какие частоты при-
сутствуют в сигнале и с какой амплитудой. Для синусоидальной 
функции, как в нашем примере, преобразование Фурье будет пред-
ставлять собой два пика: один на частоте f = 1 Гц с амплитудой A = 1 
и другой на частоте f = −1 Гц (из-за симметрии). 

Полезная аналогия возникает при сравнении преобразования 
Фурье со стеклянной призмой. Призма представляет собой физиче-
ский прибор, который разлагает свет на различные цвета в зависимо-
сти от длины (частоты) электромагнитных волн его составляющих. 
Преобразование Фурье можно представлять себе как своего рода «ма-
тематическую призму», которая также разделяет функцию на различ-
ные составляющие в зависимости от ее «частотного содержания». 
Рассматривая свет, мы говорим о его спектральном составе. Анало-
гично преобразование Фурье позволяет нам описать функцию с по-
мощью совокупности составляющих ее частот. Подставляя по ходу 
лучей вторую призму, можно собрать все лучи обратно. 

Пара двух интегральных выражений, которые мы здесь не при-
водим, составляют пару преобразований Фурье. Первая из них со-
здает образ Фурье-преобразования, далее, зная Фурье-образ, можно 
получить исходную функцию – обратное преобразование. Един-
ственным моментом, на который следует обратить внимание, явля-
ется тот факт, что используемые функции содержат комплексные 
числа, так как они позволяют хранить больше информации о сигнале. 
Указанные преобразования можно легко распространить на функции 
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двух переменных. Достаточно интересно выглядит результат преоб-
разования в виде изображения (рис. 7). 

Основными функциями Фурье-преобразования являются: 
– анализ сигналов. Позволяет исследовать, какие частоты доми-

нируют в сигнале. Это полезно в таких областях, как обработка звука, 
изображений и электроники; 

– удаление шума. С его помощью можно выделять полезные сиг-
налы, отвергая нежелательные шумы, которые находятся вне опре-
деленных частотных диапазонов; 

– изучение временных рядов. В экономике и финансах Фурье-преоб-
разование помогает выявлять циклы и сезонные колебания в ряде данных. 

 

 
 а б в г 

Рис. 7. Исходное изображение поверхности бумаги (а), 
ее Фурье-образ (б), скорректированный Фурье-образ (в)  
и конечный результат после Фурье-преобразования (г)  

 
Удаление шума из двумерных изображений с использованием 

Фурье-преобразования – это распространенный метод в обработке 
изображений. Данный процесс включает преобразование изображе-
ния в частотную область, где шумы могут быть легко идентифициро-
ваны и удалены. Вот как это происходит по шагам. 

Шаг 1: Преобразование изображения. 
1. Загрузка изображения, у которого вы хотите удалить шум. 
2. Применение двумерного Фурье-преобразования. Двумерное 

Фурье-преобразование (2D-Фурье-преобразование) преобразует каж-
дую точку изображения (пиксель) из пространственной области в ча-
стотную область. В результате вы получите спектр частот, где каждая 
точка на новом изображении представляет собой амплитуду и фазу 
определенной частоты в исходном изображении (см. рис. 7). 

Шаг 2: Анализ частотной области. 
1. Частотный спектр. После применения Фурье-преобразования 

вы получите частотный спектр изображения. В этом спектре: 
– низкие частоты обычно соответствуют общим, плавным измене-

ниям в изображении (например, фоны или большие структуры); 
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– высокие частоты соответствуют резким изменениям (например, 
края, текстуры и шум). 

2. Идентификация шума. Шумы чаще всего находятся в высоко-
частотной области спектра. Это может быть случайный шум, появля-
ющийся в изображении, или регулярные шумовые характеристики. 

Шаг 3: Удаление шума. 
1. Фильтрация частот. Применяются фильтры (обычно полосо-

вые или низкочастотные) для удаления нежелательных высокоча-
стотных составляющих.  

Например, если используется низкочастотный фильтр, он про-
пускает низкие частоты и подавляет высокие, позволяя удалить шум, 
сохраняя при этом основные структуры изображения. 

Существуют разные типы фильтров: 
– низкочастотные фильтры (например, гауссовый фильтр) улуч-

шают гладкость изображения, подавляя резкие изменения (шум); 
– высокочастотные фильтры могут быть применены для выделе-

ния краев, но в данном случае они не используются, если цель – уда-
лить шум. 

2. Настройки фильтров. Задаются параметры фильтра, такие как 
радиус, в пределах которого высокие частоты будут подавлены. 
Цель – найти баланс между удалением шума и сохранением важных 
деталей изображения. 

Шаг 4: Обратное преобразование. 
1. Обратное Фурье-преобразование. После фильтрации следует 

вернуться в пространственную область, применив обратное Фурье-
преобразование (Inverse Fourier Transform). Это преобразование пре-
образует отфильтрованную частотную информацию обратно в форму 
изображения. 

2. Получение очищенного изображения. После выполнения об-
ратного преобразования получается изображение, из которого был 
удален шум, при этом изображение осталось более четким и гладким. 

Шаг 5: Оценка результатов. 
1. Сравнение изображений. Сравните оригинальное изображе-

ние с очищенным, чтобы оценить эффективность удаления шума. 
2. Дополнительная обработка. Если шум все еще наблюдается, 

вы можете повторить процесс с другими параметрами фильтрации 
или использовать другие методы. 

Удаление шума с использованием Фурье-преобразования явля-
ется мощным методом, который крайне полезен в обработке изобра-
жений. Эта методика позволяет эффективно изолировать и удалять 
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нежелательные высокочастотные компоненты, сохраняя при этом 
важные характеристики и детали изображения. 

Кроме рассматриваемых здесь программ JMicroVision и ImageJ 
имеются менее известные продукты, которые также используют пре-
образование Фурье, – GIMP (бесплатное приложение) и Python с биб-
лиотеками NumPy и SciPy. 

Восстановление изображений. Как и при улучшении изображе-
ний, конечной целью восстановления является повышение качества 
изображения в некотором заранее предопределенном смысле. Не-
смотря на пересечение областей применения методов обоих клас-
сов, улучшение изображений является в большей степени субъек-
тивной процедурой, в то время как процесс восстановления носит 
в основном объективный характер. При восстановлении делается по-
пытка реконструировать или воссоздать изображение, которое было 
до этого искажено, используя априорную информацию о явлении, 
которое вызвало ухудшение изображения. Поэтому методы восста-
новления основаны на моделировании процессов искажения и приме-
нении обратных процедур для воссоздания исходного изображения. 

Мы совершенно не уверены, что методы улучшения изобра-
жений пригодны для анализа бумаги. Это связано с тем, что шум, 
обусловленный условиями фиксации и обработки изображения, со-
поставим с естественным шумом, возникающим при получении бу-
мажного листа. Тем не менее мы кратко остановимся также без ис-
пользования математического аппарата на приемах восстановления 
изображения. 

Фактически методы восстановления условно базируются на филь-
трах, в работу которых заложены различные интерполяционные ал-
горитмы. Проблема восстановления заключается в поиске искажаю-
щей функции. Наиболее простым примером такого подхода является 
медианный фильтр. В этом методе значение пикселя заменяется ме-
дианой найденных пикселей в соседней области. Ясно, что возникают 
проблемы на краях изображения, где не существует соседних пиксе-
лей с края.  

Метод максимума, или фильтр максимума, используется для по-
давления шума, который может находиться ниже уровня максималь-
ных значений окрестности пикселя. Этот метод заменяет пиксель 
на его максимальное значение в окрестности пикселя, а окрестность 
определяется размером окна, например, 3×3. Применение этого ме-
тода пригодно для удаления небольшого шума, при этом сохраня-
ются яркие (светлые) детали. 
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Метод минимума, или фильтр минимума, напротив, использу-
ется для удаления светлых тонов или для выделения темных деталей 
на изображении. 

Метод Гаусса основан на функции, которая похожа по форме 
на колокол. Эта функция показывает, как веса пикселей в окне зави-
сят от расстояния до центрального пикселя. Пиксели, находящиеся 
ближе к центру, имеют больший вес, чем те, что находятся дальше. 
Такой фильтр удаляет высокочастотные компоненты (шум) и остав-
ляет низкочастотные (структура). Этот метод сохраняет края лучше, 
чем многие другие методы. 

Поскольку одним из параметров оценки неоднородности струк-
туры бумаги считается дисперсия яркости, которая также является 
параметром оценки качества восстановления, то приемами восста-
новления необходимо пользоваться с осторожностью и по крайней 
мере параметры восстановления не следует менять произвольно, пе-
реходя от объекта к объекту.  
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ГЛАВА 5 

ОСНОВНЫЕ ПОЛОЖЕНИЯ ТЕОРИИ ЦВЕТА 

В 1666 г. Исаак Ньютон обнаружил, что при прохождении луча 
солнечного света через стеклянную призму выходящий поток лучей 
не является белым, но состоит из непрерывного спектра цветов, про-
стирающихся от фиолетового цвета на одном конце до красного 
на другом. Спектр белого света (видимый) может быть разделен 
на шесть широких цветовых диапазонов: фиолетовый, синий, зеленый, 
желтый, оранжевый и красный. При рассмотрении полного спектра 
видно, что ни один цветовой диапазон не имеет ярко выраженных 
границ; вместо этого каждый цвет плавно переходит в другой. 

Цвет, воспринимаемый человеком как цвет объекта, определяется, 
по существу, характером отраженного от объекта света. Общеиз-
вестно, что видимый свет составляет относительно узкую часть всего 
диапазона длин волн электромагнитного спектра. Тело, которое рав-
номерно отражает свет во всем видимом диапазоне длин волн, выгля-
дит для наблюдателя как белое. Однако тело, которое отражает свет 
преимущественно в некотором ограниченном диапазоне видимого 
спектра, приобретает некоторый цвет. Так, например, объект зеле-
ного цвета отражает главным образом свет с длиной волны в диапа-
зоне от 500 до 570 нм и поглощает большую часть энергии в диапа-
зонах других длин волн. 

Важную роль в науке о цвете играет выбор параметров, характе-
ризующих свет. Когда свет является ахроматическим (неокрашенным, 
а точнее черно-белым с градациями), в роли единственной такой ха-
рактеристики выступает интенсивность. 

Хроматический (окрашенный) свет охватывает диапазон электро-
магнитного спектра приблизительно от 400 до 700 нм. Хроматиче-
ские источники света характеризуются тремя основными величинами: 
потоком лучистой энергии, световым потоком и светлотой. Поток лу-
чистой энергии, обычно измеряемый в ваттах (Вт), – это общее коли-
чество энергии, излучаемой источником света в единицу времени. 
Световой поток, измеряемый в люменах (лм), – это поток лучистой 
энергии, оцениваемой по зрительному ощущению. Например, световой 
источник, работающий в дальнем инфракрасном диапазоне, может 
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давать значительный поток энергии, но наблюдатель его практиче-
ски не ощущает, так что световой поток такого источника почти 
равен нулю. Наконец, как уже обсуждалось ранее, светлота (яр-
кость) является субъективной характеристикой, которая практиче-
ски не поддается измерению. Она отражает уровень зрительного 
ощущения, производимого интенсивностью (т. е. световым потоком), 
и является одним из ключевых параметров для описания цветового 
восприятия. 

Человеческий глаз воспринимает цвета как различные сочетания 
так называемых первичных основных цветов: красного (R), зелено-
го (G) и синего (В). В 1931 г. Международная комиссия по освеще-
нию (МКО) разработала стандартный набор монохроматических 
первичных основных цветов: синий – с длиной волны 435,8 нм, зеле-
ный – 546,1 нм и красный – 700 нм. Этот стандарт был установлен 
до того, как в 1965 г. стали доступны кривые спектральной чув-
ствительности. Поэтому стандарт МКО лишь приблизительно соот-
ветствует экспериментальным данным. Никакой монохроматический 
цвет в отдельности не может быть назван красным, зеленым или си-
ним. Кроме того, важно понимать, что наличие стандартного набора 
монохроматических первичных основных цветов не означает, что все 
цвета спектра могут быть получены на основе этих фиксирован-
ных RGB-цветов. Использование термина «основные» часто приво-
дит к тому заблуждению, что все видимые цвета могут быть воспро-
изведены при смешении основных первичных цветов в различных 
пропорциях. Такое утверждение не верно, за исключением того 
случая, когда длина волны основных цветов также может изме-
няться. В этом последнем случае, однако, мы уже не будем иметь 
трех стандартных первичных основных цветов. 

Первичные основные цвета могут складываться, что дает вторич-
ные основные цвета: пурпурный (красный плюс синий), голубой (зе-
леный плюс синий) и желтый (красный плюс зеленый). Смешение 
трех первичных основных цветов, или вторичного основного цвета и 
противоположного ему первичного, в правильных пропорциях дает 
белый цвет. 

Важно различать первичные основные цвета световых источ-
ников и первичные основные цвета красителей (светофильтров). 
В последнем случае первичный основной цвет определяется как цвет 
красителя, который поглощает или вычитает некоторый один первич-
ный основной цвет светового источника и отражает либо пропускает 
два оставшихся. Поэтому для красителей первичными основными 
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цветами являются пурпурный, голубой и желтый, а вторичными – 
красный, зеленый и синий. Правильная комбинация трех первичных 
основных цветов красителей или вторичного основного цвета и про-
тивоположного ему первичного дает черный цвет. 

Параметрами, обычно используемыми для различения цветов, 
являются светлота, цветовой тон и насыщенность. Как указывалось 
ранее, светлота связана со зрительным ощущением интенсивности 
в цветовом случае. Цветовой тон характеризует доминирующий 
цвет, воспринимаемый наблюдателем, причем большинство цвето-
вых тонов в своем восприятии эквивалентны тому или иному спек-
тральному цвету. Таким образом, когда мы называем некоторый 
объект красным, оранжевым или желтым, мы тем самым обозна-
чаем его цветовой тон. Насыщенность цвета связана с его относи-
тельной белизной, или с количеством белого цвета в нем. Спек-
трально чистые (монохроматические) цвета являются полностью 
насыщенными. Насыщенный цвет не разбеливается. Такие цвета, 
как розовый (смесь красного и белого) или бледно-лиловый (смесь 
фиолетового и белого), менее насыщены, причем величина насы-
щенности цвета обратно пропорциональна количеству белого цвета 
в смеси. 

Цветовой тон и насыщенность вместе называются цветностью, 
и поэтому цвет может быть охарактеризован своей светлотой и цвет-
ностью. Величины красного, зеленого и синего, необходимые для по-
лучения некоторого конкретного цвета, называются координатами 
цвета и обозначаются соответственно X, Y и Z. Часто при описании 
цвета светлота не представляет интереса, и в таком случае цветовой 
тон и насыщенность можно выразить в координатах цветности, кото-
рые для x определяются так: 

 .Xx
X Y Z

=
+ +

 (5) 

Другой способ задавать цвета основан на использовании диа-
граммы цветностей МКО (рис. 8), на которой вся совокупность цве-
тов представлена как функция х (красной) и у (зеленой) координат 
цветности. Очевидно, что значение синей координаты получается 
вычитанием суммы красного и зеленого из единицы. 

Диаграмма цветности полезна при рассмотрении процедуры сме-
шения цветов, поскольку отрезок, соединяющий любые две точки 
диаграммы, определяет всевозможные различные цвета, которые мо-
гут быть получены при смешении двух данных цветов. 
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Рис. 8. Диаграмма цветности 

Цветовые модели. Назначение цветовой модели (называемой 
также цветовым пространством или системой цветов) состоит в том, 
чтобы сделать возможным описание цветов некоторым стандартным, 
общепринятым образом. По существу, цветовая модель определяет 
некоторую систему координат и подпространство внутри этой си-
стемы, в которой каждому цвету соответствует единственная точка. 

В RGВ-модели каждый цвет представляется красным, зеленым и 
синим. Эти цвета называются первичными основными цветами (ком-
понентами). В основе модели лежит декартова система координат. 
Цветовое пространство представляет собой куб. Точки, отвечающие 
красному, зеленому и синему цветам, расположены в трех вершинах 
куба, лежащих на координатных осях. Голубой, пурпурный и желтый 
цвета расположены в трех других вершинах куба. Черный цвет нахо-
дится в начале координат, а белый – в наиболее удаленной от начала 
координат вершине. 

В рассматриваемой модели оттенки серого цвета лежат на диа-
гонали, соединяющей черную и белую вершины. Различные цвета в 
этой модели представляют собой точки на поверхности или внутри 
куба и определяются вектором, проведенным в данную точку из на-
чала координат. Значения координат лежат между 0 и 255. 
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Цветовые модели СМУ и СМУK. Ранее уже говорилось, что го-
лубой, пурпурный и желтый цвета являются вторичными основными 
цветами световых источников или первичными основными цветами 
красителей. Например, если поверхность, покрытая голубой краской, 
освещается белым светом, то красный цвет от такой поверхности не от-
ражается. Таким образом, голубой краситель вычитает красный цвет 
из отражаемого белого, который сам по себе состоит из одинаковых 
количеств красного, зеленого и синего цветов. Значения координат 
лежат между 0 и 100. 

Набор значений RGВ может быть легко получен из значений СМУ 
вычитанием их из единицы. Возможен и противоположный переход. 
Цветовая модель СМУ используется в процессе получения печат-
ных копий. 

Цветовая модель Lab – сокращенное название цветового простран-
ства CIE 1976 Lab* или CIELAB. В этой модели основными парамет-
рами являются: уровень света – яркость L, а также координаты цвета 
от зеленого до красного – а и от голубого до желтого – b. Значения ко-
ординат лежат для L в диапазоне 0–100, a и b – между –128 и +128. 

Известен также и ряд других малораспространенных моделей. 
Для всех этих моделей характерно явление инвариантности, т. е. из одной 
модели можно получить любую другую. Хорошей иллюстрацией ска-
занного является программа Photoshop, наиболее распространенная у 
иллюстраторов и фотографов. На рис. 9 показан соответствующий скан. 

 

 
Рис. 9. Перевод различных координат  

цветности программой Photoshop 
 
Гистограммой изображения называют график распределения 

пикселей с определенной яркостью (светлотой), где на горизонтальной 
оси показывается яркость (от 0 до 255), а на вертикальной – количество 
пикселей заданной яркости. Например, на следующей гистограмме 
яркости (рис. 10) с уровнем 80 соответствует 1106 пикселей из 120 000. 
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Рис. 10. Гистограмма изображения 

 
Эквализация гистограммы. Эквализация гистограммы – это один 

из самых простых методов улучшения качества изображения. Эквализа-
ция – это процедура выравнивания гистограммы изображения путем 
коррекции яркости отдельных пикселей. Процедура эквализации сде-
лает распределение значений в гистограмме более равномерным, а это 
значит, что в ней почти не останется пропусков и областей с чрезмерно 
высоким количеством (и высотой) пиков. Рассмотрим две гистограммы 
и два изображения, соответствующих этим диаграммам (рис. 11).  

В прикладных программах, которые мы изучаем ниже, доста-
точно найти соответствующую опцию, чтобы добиться увеличения 
контрастности. Существуют и другие способы использования гисто-
граммы для увеличения контрастности, однако нет общих правил 
по выбору гистограммы, и следует раз за разом прибегать к анализу 
в каждой из задач улучшения и оценки изображений. 

 

     

 
а      б 

Рис. 11. Гистограммы и изображения до (а) и после (б) эквализации 
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Видно, что график стал более равномерным, локальные области 
максимальной плотности ярких участков исчезли и гистограмма не-
много выровнялась. В свою очередь, это привело к тому, что контраст 
некоторых областей стал сильнее и динамический диапазон изобра-
жения стал более насыщенным, а это означает, что качество изобра-
жения стало несколько выше. 

Информационная энтропия. Вообще-то говоря, это понятие 
используется при оценке возможности сжатия изображения, 
так как определяет, какое количество информации мы можем по-
терять при такой процедуре. Однако информационная энтропия – 
это еще и мера неопределенности некоторой системы, мера ее дез-
организации.  

Поскольку пиксели изображения являются случайными величи-
нами, которые принимают значения в соответствии с некоторым рас-
пределением вероятностей Р между 0 и 1, то формула для расчета эн-
тропии примет следующий вид: 

 
1

2
0

( ) log ( ),
L

x
Н P x P x

−

=
= −  (6) 

где L – значение пикселя, равного 256; Р(х) вычисляется через гисто-
граммы путем ее нормировки. 

Очевидно, что абсолютно однородное изображение имеет энтро-
пию, равную нулю. 

Элементы математического аппарата. Рассмотренная в насто-
ящем учебно-методическом пособии программа ImageJ позволяет ис-
пользовать некоторые элементы математического аппарата для циф-
ровой обработки изображений. К ним мы относим арифметические 
и логические операции. 

Арифметические операции над изображениями являются поэле-
ментными операциями, т. е. они применяются к паре соответствую-
щих пикселей двух изображений. Эти четыре арифметические опера-
ции (условно их можно назвать сложением, вычитанием, умножением, 
делением) обозначаются следующим образом: 

  

( , ) ( , ) ( , );
( , ) ( , ) ( , );
( , ) ( , ) ( , );

( , )( , ) .
( , )

s x y f x y g x y
d x y f x y g x y
p x y f x y g x y

f x yv x y
g x y

= +
= −
=

=

 (7) 
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Для изображения с яркостью в пределах 0–255 получение величины 
более 255 следует заменить на 255, а при получении отрицательного 
значения – на 0. Ясно, что s, d, p и v являются новыми изображени-
ями. Заметим, что в такой определенной арифметике участвуют 
изображения одинаковых размеров. 

Где мы можем применять эти арифметические операции? Ока-
зывается, данный прием хорошо работает для удаления шума. Если 
предположить, что у нас имеется 100 изображений с одинаковым 
уровнем шума, то сложение таких изображений и получение среднего 
от него позволит уменьшить уровень шума в 10 раз. 

Операция вычитания изображений часто используется для выде-
ления имеющихся различий между ними. При этом, когда изображе-
ния визуально не отличаются, данная операция позволяет выделить 
мелкие детали, которые обычно не видны. 

Важной областью применения операций умножения и деления 
изображений является выравнивание фона. Это очень ценный прием, 
так как при использовании оптических микроскопов, а также других 
методов просвечивания неравномерный фон искажает конечный ре-
зультат. И хотя применение одного прибора в потоковых условиях 
совершенно не сказывается на конечном результате обработки, од-
нако при переходе на другой прибор с другим неравномерным фоном 
такое сравнение некорректно. 

Предположим, что система регистрации формирует цифровые 
изображения, которые можно смоделировать как произведение 
идеального изображения f(x, y) и функции неравномерности фона 
h(x, y), т. е. g(x, y) = f(x, y) h(x, y). Сразу следует подчеркнуть, что 
приведенные рассуждения пригодны только для случая, когда 
речь идет о логарифмических величинах. Если изображение h(x, y) 
известно, мы можем получить f(x, y) путем умножения получен-
ного изображения на обратное к h(x, y), т. е. делением g на h. Если 
h(x, y) неизвестно, но есть доступ к системе получения изображе-
ний, мы можем приближенно найти функцию неравномерности 
фона, получив изображение поля с постоянной яркостью. Даже 
если доступ к регистрирующей системе невозможен, часто можно 
оценить характер неравномерности фона непосредственно по 
изображению. 

В случае, если значения яркости не прологарифмированы, то из 
значения фона необходимо вычесть значения яркостей итогового 
изображения. 
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Логические операции с изображениями. Известны четыре логи-
ческие операции (рис. 12):  

– объединение; 
– пересечение; 
– дополнение; 
– разность двух множеств. 
Затемненные области на рис. 12, б–д представляют собой эле-

менты множеств, являющихся результатом указанной операции. 
 

 
Рис. 12. Результаты логических операций с изображениями: 

а – два множества координат на плоскости A и B;  
б – объединение множеств A и B;  
в – пересечение множеств A и B;  
г – разность множеств A и B;  
д – дополнение множества A 

 
В случае полутонов операции объединения и пересечения обычно 

определяются как соответственно максимум и минимум для пары со-
ответствующих пикселей, а дополнение определяется как попарные 
разности между яркостью каждого пикселя. 

Операция дополнение обычно используется для получения нега-
тива при условии, что яркость внесена в матрицу как логарифмиче-
ская величина. В противном случае должно применяться вычитание. 
Обычно из 255 вычитается яркость каждого пикселя. Для облегче-
ния многие мощные графические редакторы имеют опцию «Инвер-
сия», и пользователь совершенно не задумывается, каким образом 
получается негатив. 
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Чаще всего логические преобразования типа ИЛИ, И, НЕ исполь-
зуются при работе с бинарными изображениями. Логические операции 
широко применяются при морфологической обработке изображений. 

Нечеткие множества. Обычно логические результаты опери-
руют четкими понятиями в том смысле, что элемент либо принадле-
жит, либо не принадлежит множеству. В некоторых приложениях 
это сильно ограничивает возможности.  

Рассмотрим простой пример. Предположим, что мы хотим поде-
лить всех людей на две категории – молодых и немолодых. Применяя 
четкие множества, обозначим через U множество всех людей и пусть 
A – подмножество U, которое назовем множеством молодых людей. 
Чтобы задать множество A, необходима функция принадлежности, 
которая сопоставляет каждому человеку из U значение 0 или 1. 
Если элементу U сопоставлено значение 1, то этот элемент принадле-
жит A, и наоборот. Поскольку мы оперируем двузначной логикой, 
функция принадлежности просто задает порог для возраста, при ко-
тором (и меньших значениях) человек считается молодым, а выше ко-
торого – немолодым.  

Допустим, что мы определили как молодых всех людей, имею-
щих возраст 20 лет и меньше. Сразу появляется трудность: человек, 
чей возраст составляет 20 лет и 1 секунду, не должен входить в мно-
жество молодых людей. Такое ограничение возникает вне зависи-
мости от значения порога, принятого для классификации людей 
как молодых. Хотелось бы иметь более гибкое определение того, 
что подразумевается под «молодостью», т. е. иметь постепенный пе-
реход из молодых в немолодые. Теория нечетких множеств реализует 
эту идею с помощью функций принадлежности, которые постепенно 
меняются в интервале между граничными значениями 1 (определенно 
молодой) и 0 (определенно немолодой). С помощью нечетких мно-
жеств можно сделать утверждение, что некоторый человек на 50% 
молодой (находится в середине перехода от молодого к немолодому). 
Иначе говоря, возраст представляет собой неточное понятие, и нечет-
кая логика дает возможность работы с такими понятиями. 

Рассмотрим обычную проблему повышения контрастов – одного 
из основных приложений из области яркостных преобразований. 
Можно сформулировать процесс повышения контрастов полутонового 
черно-белого изображения, используя следующие правила: 

1) ЕСЛИ пиксель темный, ТО сделать его темнее; 
2) ЕСЛИ пиксель серый, ТО сделать его серым; 
3) ЕСЛИ пиксель светлый, ТО сделать его светлее. 
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Имея в виду, что это нечеткие термины, можно выразить концеп-
ции темный, серый и светлый при помощи функции принадлежно-
сти, показанной на рис. 13, а. В терминах выходного результата можно 
рассматривать термин темнее как означающий «иметь степень ярко-
сти в области более темных значений» (100% черный означает пре-
дельный уровень темного); термин светлее означает «иметь степень 
яркости в области более светлых значений» (100% белый является 
предельным значением светлого); серый означает «иметь степень яр-
кости в области средних значений шкалы». Под степенью здесь по-
нимается величина некоторой конкретной яркости; например, 80% 
черный является очень темным серым. 

При модификации константных яркостей выходные функции 
принадлежности получают одно значение, т. е. также являются кон-
стантами (рис. 13, б). 

 
Рис. 13. Входная (а) и выходная (б) функции принадлежности  
для повышения контраста на основе правил нечеткой логики 

 
Нечеткая обработка изображений требует интенсивных вычисле-

ний, поскольку весь процесс размывания, обработки исходных условий 
для всех правил, импликация, объединение и устранение нечеткости 
должны быть применены к каждому пикселю входного изображения. 

На рис. 14, а представлено изображение с узким диапазоном яр-
костей, что приводит к впечатлению низкого контраста на изобра-
жении. В качестве базы для сравнения на рис. 14, б показан результат 
эквализации гистограммы. Как видно из рис. 14, б, растягивание диа-
пазона усиливает контраст, однако в итоге значения пикселей ока-
зываются в нижнем и верхнем концах шкалы яркостей, и изображе-
ние приобретает вид «переэкспонированного». В частности, детали 
на лбу и в волосах Альберта Эйнштейна по большей части утеряны. 
На рис. 14, в представлен результат модификации контраста на ос-
нове использования правил нечеткой логики. 
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Рис. 14. Результат эквализации исходного малоконтрастного изображения (а) 
и результат эквализации гистограммы (б),  

а также применения метода повышения контраста,  
основанного на правилах нечеткой логики (в) 

 
Кластеризация – это разбиение элементов некоторого множе-

ства на группы по принципу схожести (рис. 15). Фактически речь 
идет о сегментации изображений. Эти группы принято называть кла-
стерами. Важным элементом этого приема является понятие меры 
близости, среди которой широко используется евклидово расстояние.  

Метод k-средних – один из популярных итеративных методов 
кластеризации данных. Второй метод, не вникая в его сущность, мы 
затронем при описании программы ImageJ. Он быстр и эффективен 
в применении. 

Рассмотрим алгоритм на примере растрового изображения. 
В качестве объектов будут выступать пиксели изображения, а в каче-
стве характеристик – их цвет. 

1. Выбирается число k – количество кластеров.  
2. Далее случайным образом из заданного изображения выби-

рается k точек. На первом шаге эти точки будут считаться центрами 
кластеров. Каждому кластеру соответствует один центр.  

3. Все точки изображения распределяются по кластерам. Вычис-
ляется расстояние от любой точки до каждого центра кластера. Кла-
стеризация изображения методом k-средних точку относит к тому 
кластеру, расстояние до центра которого будет наименьшим.  

4. Когда все точки изображения распределены по кластерам, 
происходит пересчет центров кластеров. В качестве нового центра 
кластера берется среднее арифметическое всех точек, принадлежа-
щих кластеру. 
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 а б 

Рис. 15. Изображение бумаги «Снегурочка»  
до (а) и после (б) кластеризации (5 кластеров, 40 итераций) 

 
Формат графического файла – это способ записи графических 

данных. Максимальная детализация графических данных проис-
ходит при создании файла изображения и не может быть увеличена 
при увеличении масштаба. Пиксели превращаются в расплывчатые 
квадраты (рис. 16).  

 

  
Рис. 16. Растровое изображение в двух масштабах (губы) 

 
Известно несколько десятков видов формата, но так как нас ин-

тересуют полутоновые виды изображения, то вкратце остановимся 
на форматах JPEG, BMP, GIF, PNG, TIFF. 

JPEG (Joint Photographic Experts Group) предназначен для изоб-
ражений фотографического качества. Его базовая система сжатия 
реализуется с потерями. Является одним из наиболее популярных 
способов кодирования изображений, в том числе и по причине не-
большого объема. Имеет ряд модификаций, например, стандарт сжа-
тия больших полутоновых изображений без потерь (или с ограничен-
ными, задаваемыми пользователем потерями). 

BMP (Windows Bitmap) используется в основном для простых не-
сжатых изображений. 
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GIF (Graphic Interchange Format) предназначен для кодирования 
без потерь. 

PNG (Portable Network Graphics) сжимает без потерь изображе-
ния в натуральных цветах. 

TIFF (Tagged Image File Format) представляет собой гибкий файло-
вый формат, поддерживающий множество разных стандартов сжатия. 

Наряду с растровой графикой существует и векторная. Век-
торная графика – это способ представления изображений при помощи 
множества точек, которые объединяет математическая модель. Фак-
тически каждое изображение является графиком математической 
функции, что позволяет ему сохранять качество отображения при из-
менении масштаба. В отличие от растрового рисунка, который пред-
ставляет набор пикселей разных цветов, векторное изображение – 
это набор примитивов (линий, кривых, квадратов, кругов), описан-
ных математическими формулами. Рисунок формируется в виде файла, 
который содержит данные о координатах точек и о линии, пересека-
ющей опорные точки. Кроме того, файл включает информацию о 
примененных эффектах. 
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ГЛАВА 6 

ПРОГРАММНЫЕ СРЕДСТВА 
ОБРАБОТКИ ИЗОБРАЖЕНИЙ 

Avizo. Программа предназначена для работы с изображениями мик-
роструктур, определения их дефектов, а также основных морфологи-
ческих параметров: импорт данных, визуализация, сегментация, ана-
лиз, анимация (базовый набор функций), расширенная сегментация и ее 
количественная оценка, сегментация и анализ волокон, характеристика 
и моделирование сети пор, моделирование свойств материалов, цифро-
вая корреляция для измерения деформации материала, локализация и 
визуализация больших многоканальных и временных рядов данных.  

В качестве примера рассмотрим результат деконволюции в про-
грамме Avizo (рис. 17). 

 

     
 а  б 

Рис. 17. Проекции максимальной интенсивности до (а) и после (б)  
восстановления четкости изображения, которые могут быть  

потеряны из-за искажений, возникающих при прохождении света  
через оптические элементы микроскопа (деконволюция) 

 
На рис. 18 представлено удаление отверстия размером менее 

200 пикселей. 
 

     
Рис. 18. Удаление отверстия заданного размера в Avizo 
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Системы анализа изображений серии Image Experttm. Целью 
программы является определение качественных и количественных 
характеристик. В программе имеется возможность записи методик, 
представление и хранение результатов осуществляется в любой форме: 
таблицы, гистограммы, изображение и т. д. Кроме того, Image Experttm 
позволяет работать с камерой удаленно и настраивать оптическую си-
стему комплекса. 

Наиболее интересным вариантом является трехмерная визуали-
зация с использованием технологии OpenGL, с помощью которой 
получается реалистичное изображение цветового профиля при плав-
ном его вращении в заданных направлениях, а полупрозрачная се-
кущая плоскость (уровень «моря») дает наглядное представление об 
уровнях для преобразований и улучшает визуальное восприятие. 
На рис. 19 показана визуализация 3D-профиля, полученного послой-
ной микроскопией. 

 

 
Рис. 19. Визуализация 3D-профиля 

 
Анализатор Image Experttm Gauge предназначен для получения 

изображений анализируемых структур и материалов, наблюдаемых 
в микроскоп, с проведением простых геометрических измерений 
элементов структуры в реальных физических единицах. Встроенный 
в программу мастер съемки работает с широким спектром анало-
говых и цифровых видеокамер. При работе с камерами высокого 
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разрешения реализована возможность ступенчатого масштабирова-
ния для режима отображения видео и для сохраняемых изображений. 
Анализатор изображений поддерживает наиболее популярные графи-
ческие растровые форматы. 

Программа Image Experttm Sample 2 – это программное обеспе-
чение для качественного анализа изображений, полностью или ча-
стично ориентированное на анализ структур посредством сравнения 
с эталонами.  

Видеотест. Программа имеет аналогичные возможности, а именно: 
позволяет распределять объекты по их яркости, а также определять 
геометрические формы в трехмерном пространстве благодаря инте-
грации в программу успешных оптических методов. Пример исполь-
зования программы для проведения бинаризации с произвольным по-
рогом приведен на рис. 20. 

 

 
Рис. 20. Результат бинаризации изображения  

в программе Видеотест 
 
MetaXpress®. Программное обеспечение MetaXpress® – это плат-

форма для получения и анализа 2D- и 3D-изображений. Модуль 
анализа 3D-изображений может анализировать сфероиды, микро-
ткани, клетки в 3D-матрице и небольшие организмы. Модульная па-
нель инструментов позволяет быстро настраивать сотни обычно исполь-
зуемых высококонтентных анализов. Продукт дает возможность 
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выполнять расширенные анализы, такие как идентификация объек-
тов внутри объектов и создание морфометрических классификато-
ров для анализа формы. На рис. 21 приведены результаты исполь-
зования адаптивной коррекции фона. 

 

 
Рис. 21. Результаты сегментации изображения в MetaXpress® 

 
ImageJ. Программа для обработки и анализа изображений с от-

крытым исходным кодом, написанная National Institutes of Health 
на языке Java, что позволяет автоматизировать сложные повто- 
ряющиеся действия. Открытый код дает возможность добавлять 
дополнительные модули (плагины) людям, не являющимся разра-
ботчиками. Плагины позволяют расширить функционал програм- 
мы и проводить визуализацию вплоть до рентгенологических изо-
бражений. 

Endrov. Программа с открытым исходным кодом для обра-
ботки и анализа изображений основана на языке Java и большей 
части философии ImageJ, но старается заменить ее при помощи 
современного дизайна. Программа построена так, чтобы разграни-
чивать код графического интерфейса от других данных, модулей 
и фильтров, а также их между собой. Упор делается на то, чтобы 
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уменьшить избыточность кода и упростить обслуживание. Данную 
программу можно считать приемником, учеником ImageJ. Продукт 
совмещает в себе и библиотеку данных, и программу для визуа-
лизации, при этом разделяя все между собой и нарушая обратную 
совместимость ради дизайна, считая, что большое количество пла-
гинов без нарушения совместимости приводит к ошибкам в ди-
зайне. Из особенностей можно выделить обработку дополнительных 
измерений, что важно для серьезной микроскопии, еще у программы 
есть собственный формат изображений, что не мешает ей поддер-
живать и другие наиболее распространенные форматы. 

На рис. 22 приведен пример окна Endrov. 
 

 
Рис. 22. Пример окна Endrov 

 
MIPAR. Это современная высокоэффективная программная 

система для обработки и анализа изображений, которая способна 
идентифицировать и оценивать характеристики объектов практи-
чески на любых изображениях. Широкое разнообразие областей ис-
пользования программного продукта делает систему одним из наибо-
лее универсальных и гибких решений. Изначально система MIPAR 
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была разработана для решения задач анализа изображений в мате-
риаловедении, однако с тех пор проделала большой путь в своем 
развитии. Сегодня система используется исследовательскими ла-
бораториями, в университетах, в небольших компаниях и крупных 
корпорациях, а области применения варьируются от анализа изо-
бражений атомов до обработки аэроснимков. Дополнительный 
модуль MIPAR содержит инструменты для работы с 3D-изобра-
жениями. 

Принципы работы с MIPAR основаны на использовании специ-
альных наборов правил (Recipes). Готовые наборы команд доступны 
для бесплатного скачивания с сайта, их можно применять в качестве 
основы для разработки собственных программ. Их разработка не тре-
бует программирования, а осуществляется через современный лен-
точный интерфейс системы. Каждый готовый набор команд легко мо-
дифицировать, использовать итерационно, а также распространять 
среди коллег. 

Структура наборов команд позволяет формировать последова-
тельности команд из алгоритмического ядра MIPAR и контролиро-
вать порядок их выполнения. Каждую встроенную процедуру можно 
применять с настройками по умолчанию либо, при необходимости, 
проводить дополнительные настройки внутренних параметров. Лю-
бую готовую программу можно использовать для потоковой обра-
ботки нескольких однотипных изображений. Результаты обработки 
можно дополнительно обработать в ручном режиме, а затем сгенери-
ровать отчет с результатами анализа. 

Ниже приведено несколько примеров выполнения обработки 
изображения на платформе MIPAR (рис. 23–27). 

 

 
Рис. 23. Кластеризация (алгоритм k-cредних) в MIPAR 
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Рис. 24. Преобразование Фурье на платформе MIPAR 

 
Рис. 25. Сегментация в MIPAR 

 
Рис. 26. Гистограмма, полученная в MIPAR 
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Рис. 27. Морфология в MIPAR 

 
CMEIAC. Программный продукт процедур обработки изображе-

ний, включающий настройку контрастности/яркости, резкость, вычи-
тание фона, медианное сглаживание, преобразование цвета в оттенки 
серого, усреднение стека, растяжение гистограммы, свертку соседства 
и ручной редактор пикселей. Обновленная версия содержит три инстру-
мента редактирования изображений для облегчения сегментации объ-
ектов на изображениях перед анализом с улучшенными технологиями 
обработки изображений. Это приложение предназначено для помощи 
в исследованиях, использующих цветовые классификации. Оно имеет 
гибкую, определяемую пользователем настройку цветового допуска для 
интерактивной выборки обучающего набора локальных цветных пик-
селей, находит границу каждой клетки и, наконец, создает новое сегмен-
тированное выходное изображение RGB, содержащее эти окрашенные 
передним планом микробы на фоне без шума. Его производительность 
была тщательно протестирована на многих сложных цветных изобра-
жениях, проанализированных попиксельно по одному за раз. В резуль-
тате было установлено, что CMEIAC работает с точностью ~99%.  

Это программное приложение также включает другие проце-
дуры обработки изображений для заполнения пустых отверстий в 
объектах, удаления пиксельного шума путем расширения/эрозии, разде-
ления изображений на каналы их цветовой модели RGB/HSI/YUV, 
псевдоцветные характеристики объектов, отличающиеся по яркости, 
для помощи в определении их контура (особенно важно во флуорес-
центной микроскопии) и установки пороговых значений для размера 
объекта и фильтрации яркости.  
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Продукт имеет плагин CMEIAS Object Separation для автомати-
ческого разделения соприкасающихся объектов на пороговых изоб-
ражениях. Он работает с точностью 95,8% и имеет уникальный ди-
зайн, который позволяет избежать удаления пикселей, что приводит 
к ошибочному уменьшению размера сегментированных объектов, в 
отличие от других автоматизированных инструментов разделения 
объектов (например, watershed), представленных в другом программ-
ном обеспечении для обработки изображений. 

Ниже показан результат обработки изображений для выделения 
объектов переднего плана по цветовой сегментации (рис. 28 и 29). 

 

                  
Рис. 28. Обработка в CMEIAC пикселей переднего плана и фона,  

которые схожи по оттенку цвета, но различаются по яркости 
 

       
Рис. 29. Цифровые изображения:  
а – исходное изображение; 

б–г – то же изображение, разделенное соответственно  
на красный, зеленый и синий хроматические каналы 

а б 

в г 
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Отдельно остановимся на так называемых инструментальных 
платформах, сочетающих оптический микроскоп и программный 
комплекс по обработке данных. 

SIAMS Photolab. Данная инструментальная платформа на базе 
электронных таблиц SIMAGIS обеспечивает автоматическое полу-
чение результата количественного металлографического анализа 
от ввода изображения с микроскопа до формирования отчета. В ком-
плект базовых инструментов для автоматизации работы с изобра-
жениями входят: «Градуировка системы», «Рабочая таблица» – ин-
струмент, позволяющий захватывать изображения с видеокамеры 
или сканера, импортировать изображения из файла, сохранять, экс-
портировать, обрабатывать изображения, используя встроенные 
функции и создавать отчеты, «Измерение объектов», «Измерение 
углов и длин», «Реконструкция сфокусированного изображения», 
«Сшивка изображений», «Примеры решений». 

В программе встроены функции для улучшения качества изоб-
ражения (яркость/контраст, баланс цвета, выравнивание освещенно-
сти, повышение резкости, расширение фокуса, сшивка смежных по-
лей зрения, вычитание помех, дефектов пробоподготовки, поворот, 
отражение, обрезка по рамке и др.), а также для измерения парамет-
ров структуры (длин, диаметров, площадей, углов, расстояний между 
кривыми).  

Optika Vision Pro. Это профессиональное программное обеспе-
чение для анализа изображений к аналогичному микроскопу. Сег-
мент PROView включает в себя все функции пакета LITEView – 
базовые функции обработки изображений и коррекции фона, но в до-
полнение позволяет реализовать следующие опции: баланс белого 
и черного, полностью настраиваемый графический интерфейс, визу-
ализация многоканальных флуоресцентных изображений с функцией 
«сдвига пикселей».  

В качестве иллюстрации работы приведем пример (рис. 30), 
как Оptika Vision Pro строит гистограммы для всех трех каналов ак-
тивного изображения на основе цветовой модели RGB. В черном 
квадратном поле ось x представляет значение цвета от самого тем-
ного (0) в крайнем левом углу до самого яркого (255) в крайнем пра-
вом; ось y представляет частоту, т. е. общее количество пикселей с 
этим значением; начало гистограммы – нижний левый угол черного 
поля. Гистограммы красного, зеленого и синего каналов показаны в 
той же системе координат, что и красные, зеленые и синие полосы, и 
поэтому они могут перекрываться. 
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Рис. 30. Гистограмма, полученная  

в Оptika Vision Pro 
 
Данный продукт имеет интересную функцию, на которую редко 

обращают внимание, смиряясь с проблемой битых пикселей в ка-
мере. Используя команду Remove Bad Pixels для обнаружения и ис-
правления неисправных пикселей, можно проиллюстрировать про-
цесс (рис. 31). 

 

   
а    б    в 

Рис. 31. Удаление битых пикселей на фоновом изображении: 
а – изображение, полученное камерой с дефектными пикселями; 

б – результат применения команды; 
в – результат выполнения команды дважды 

 
JMicroVision. JMicroVision – это современное программное обес-

печение, разработанное для визуализации и анализа данных, которое 
находит широкое применение в научных, медицинских и техниче-
ских областях. Программа создана с акцентом на удобство использо-
вания и мощные аналитические функции, что делает ее идеальным 
инструментом для исследователей и специалистов. С момента своего 
выхода на рынок JMicroVision зарекомендовала себя как надежный 
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инструмент, способствующий более глубокому пониманию исследу-
емых объектов и процессов. 

Процесс визуализации данных играет важную роль в анализе ре-
зультатов экспериментов и наблюдений, позволяя выявлять законо-
мерности и аномалии, которые могут быть невидимыми при анализе 
«сырых» данных. JMicroVision предлагает пользователям широкий 
спектр инструментов для обработки изображений, анализа сигналов 
и визуализации многомерных данных. 

Основные функции. Одной из ключевых особенностей JMicro-
Vision является ее многофункциональность. Рассмотрим подробнее 
основные функции программы. 

1. Инструменты для визуализации данных: 
– JMicroVision поддерживает создание различных типов графи-

ков, включая линейные, гистограммы, 3D-графики и тепловые карты. 
Пользователи могут настраивать различные параметры визуализации, 
такие как цветовая схема, размер точек и масштаб, что помогает 
лучше представить данные; 

– программа также позволяет накладывать несколько наборов 
данных на один график, что упрощает сравнение и анализ взаимосвя-
зей между различными переменными; 

– имеется возможность экспорта графиков в форматы изобра-
жений (JPEG, PNG, TIFF) или в векторные форматы (SVG, PDF) 
для дальнейшей обработки в графических редакторах или пред-
ставления в публикациях. 

2. Анализ и обработка сигналов: 
– инструменты для временного анализа сигналов позволяют 

пользователям выявлять регулярности и паттерны в данных за счет 
применения алгоритмов фильтрации, сглаживания и спектрального 
анализа; 

– поддержка Фурье-преобразования дает возможность выполнять 
частотный анализ сигналов, что полезно в приложениях, связанных 
с акустикой, оптикой и электротехникой; 

– программа также включает функции по анализу рандомизиро-
ванных сигналов, что позволяет исследователям работать с данными, 
которые могут быть подвержены шумам или осцилляциям. 

3. Поддержка различных форматов данных: 
– JMicroVision совместима с множеством форматов данных, вклю-

чая CSV, TXT, HDF5 и др. Это позволяет пользователям легко им-
портировать данные из различных источников, в том числе резуль-
таты экспериментов, архивы данных и базы данных; 
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– функции пакетной обработки дают возможность пользовате-
лям загружать и обрабатывать большие объемы данных одновре-
менно, что существенно экономит время при выполнении рутин-
ных задач. 

4. Настройки и параметры пользователя: 
– JMicroVision предлагает гибкие настройки интерфейса, что по-

зволяет пользователям адаптировать рабочее пространство под свои 
предпочтения. Это включает настройку расположения панелей, выбор 
инструментов, которые часто используются, и кастомизацию хоткеев; 

– в программе также есть возможности для сохранения пользова-
тельских макетов, что позволяет пользователям быстро переклю-
чаться между различными конфигурациями рабочего пространства в 
зависимости от задач. 

Интерфейс пользователя. Для успешной работы с любым про-
граммным обеспечением важным аспектом является его интерфейс. 
В JMicroVision интерфейс разработан с акцентом на удобство и инту-
итивность. 

Главное меню и панели инструментов. Основное меню включает 
разделы для загрузки данных, выполнения анализа, настройки визуа-
лизации и сохранения результатов. Каждая функция имеет подсказки, 
что облегчает использование программы. 

Панели инструментов являются настраиваемыми, часть пользо-
вателей может выбрать только те инструменты, которые необходимы 
для их работы, что упрощает навигацию. 

Рабочая среда. Живые окна позволяют пользователям открывать 
несколько графиков и таблиц одновременно, что делает сравнитель-
ный анализ данных более доступным. 

Программа предоставляет возможность перетаскивать и менять 
размеры различных элементов интерфейса для создания наиболее 
удобного рабочего пространства. 

Применение в научных исследованиях. JMicroVision находит 
широкое применение не только в научных исследованиях, но и в про-
мышленности.  

Анализ поверхности бумаги является одним из популярных 
направлений использования JMicroVision. Исследование свойств 
бумаги имеет значение для целого ряда отраслей – от полиграфии 
до текстиля. С помощью JMicroVision исследователь может: 

1) собирать данные: загружать микроизображения образцов бу-
маги, сделанные с помощью электронного или оптического мик-
роскопа; 
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2) обрабатывать изображения: применять фильтры для удаления 
помех и шумов, что позволяет получить более четкие изображения 
для дальнейшего анализа; 

3) измерять текстурные характеристики: программа предостав-
ляет возможность проводить анализ текстуры, выравнивая неров-
ности поверхности. Исследователь может измерить степень шеро-
ховатости поверхности, что является критическим фактором для 
оценки качества бумаг. 

Например, с помощью JMicroVision можно вычислить значе-
ние среднеквадратичной шероховатости (RMS) поверхности бумаги. 
Это значение может помочь в оценке совместимости бумаги с раз-
личными печатными методами; 

4) выполнить сравнительный анализ: пользователи могут про-
вести сравнительный анализ нескольких образцов бумаги, визуали-
зируя результаты на одном графике, что упрощает интерпретацию 
данных и позволяет делать более обоснованные выводы. 

Достоинствами использования JMicroVision являются: 
– удобство интерфейса: программа обладает интуитивно понят-

ным интерфейсом, который делает ее доступной как для опытных, 
так и для новых пользователей; 

– многофункциональность: JMicroVision предлагает множество 
инструментов для анализа и визуализации, что делает ее универсаль-
ным решением для различных исследований; 

– широкая поддержка форматов данных: возможность работы с 
различными форматами данных позволяет легко интегрировать про-
грамму в существующие рабочие процессы; 

– активное сообщество: JMicroVision поддерживается активными 
пользователями, благодаря чему пользователи могут находить советы 
и обмениваться опытом. 

К недостаткам использования JMicroVision относятся: 
1) более узкий функционал, чем у ImageJ; 
2) время от времени зависание в операционной системе 

Windows.  
Системные требования. Программу JMicroVision можно уста-

новить на любой платформе, поддерживающей Java 1.5 и JAI (Java 
Advanced Imaging). Кроме того, Windows, Linux, Solaris и Mac OS X 
(частично) имеют собственные ускорители, которые повышают про-
изводительность программы. Для работы программе необходимы ми-
нимум 256 Мбайт ОЗУ (рекомендуется 512 Мбайт для обработки 
больших изображений), а также 60–90 Мбайт свободного места на 
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диске (включая виртуальную машину Java). Для установки на Mac OS X 
потребуется только 3,2 Мбайт. 

Помощь в Internet. Для загрузки последней версии, справки 
и ресурсов следует пройти по ссылке: http://www.jmicrovision.com. 
Если пользователь столкнулся с проблемой в программе, то мо-
жно сообщить об этом в систему отслеживания ошибок по ад-
ресу: http://www.jmicrovision.com/mantis. Техническая поддержка 
в JMicroVision бесплатная, поэтому официальная техническая под-
держка недоступна, но пользователь может отправлять свои во-
просы или проблемы по адресу: support@JMicroVision.com. Интер-
активная справка осуществляется по приложению. Для этого в 
меню справки JMicroVision следует выбрать Содержание и Индекс. 
Чтобы просмотреть раздел справки, непосредственно связанный с 
текущим окном, необходимо нажать кнопку Справка в программе. 

Поддерживаемые форматы файлов для загрузки изображе-
ний. В JMicroVision поддерживаются следующие форматы: BMP, 
FlashPIX, GIF, JPEG, PNG, PNM и TIFF.  
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ГЛАВА 7 

ФУНКЦИОНАЛЬНЫЕ ВОЗМОЖНОСТИ 
И ОБЛАСТИ ПРИМЕНЕНИЯ IMAGEJ 

ImageJ – это программа для научного анализа изображений. Со-
зданная Национальным институтом здравоохранения США, ImageJ 
является общественным достоянием (лицензия Public domain), может 
быть запущена на различных операционных системах, для которых 
есть виртуальная машина Java. Название ImageJ происходит от Image 
(изображение) и Java – язык, на котором написана программа. Ска-
чать ImageJ можно по адресу: http://imagej.nih.gov/ij/download.html. 

ImageJ – свободно распространяемое программное обеспечение 
с открытым исходным кодом. Вы можете свободно запускать про-
грамму в любых целях, изменять ее для своих задач, распространять 
среди любых стран и пользователей. 

Для изменения количества оперативной памяти, используемой 
ImageJ, воспользуйтесь командой Edit → Options → Memory & Threads. 
Не рекомендуется устанавливать в поле Maximum memory значение, 
большее 75% от общей оперативной памяти компьютера. 

Окна. Основное рабочее окно программы ImageJ содержит строку 
меню, строку инструментов, строку состояния и строку изменения 
(рис. 32). Изображения, гистограммы, профиль линии и другие эле-
менты отображаются в дополнительных окнах. 

 

 
Рис. 32. Основное окно программы ImageJ 

Результаты измерения отображаются в окне Results. Окна можно 
перетаскивать по экрану и изменять их размер. Гистограммы и гра-
фики обычно изображаются в окнах, с которых их можно скопиро-
вать во внутренний буфер обмена, отредактировать, напечатать или 
сохранить. 

Строка меню 
 

Строка  
инструментов 
 

Строка  
состояния 
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Строка инструментов (Toolbar). Строка инструментов содер-
жит инструменты выбора, инструменты для изменения масштаба 
изображения и прокрутки изображений, инструменты для изменения 
цвета рисунка. Нажмите на иконку инструмента, и описание этого ин-
струмента отобразится в строке состояния. 

Строка состояния (Status Bar). Строка состояния отображает 
пиксельные координаты и значения на изображении в том месте, 
где в данное время стоит курсор. При включении фильтра отобража-
ется прошедшее время и скорость обработки в пикселях/секундах. 

Строка изменений (Progress Bar). Строка изменений, располо-
женная справа от строки состояния, показывает изменение операций 
во времени. Она не будет появляться, если для совершения операции 
требуется менее или приблизительно 1 с. 

Изображения. Программа ImageJ позволяет нескольким изобра-
жениям быть отображенными на экране одновременно. При этом ак-
тивное окно подсвечивается в области заголовка. Все операции будут 
выполняться на активном изображении. ImageJ поддерживает 8-, 16- 
и 32-битные черно-белые изображения и 8- и 32-битные цветные 
изображения. 8-битные изображения представлены целыми числами 
без знака в диапазоне от 0 до 255. 16-битные изображения исполь-
зуют целые числа без знака в диапазоне от 0 до 65 535, а 32-битные 
черно-белые изображения – числа с плавающей точкой, т. е. числа 
в экспоненциальном виде (порядка двух миллиардов значений). 

Стеки. Программа ImageJ может отобразить множество простран-
ственно или временно связанных изображений в одном окне. Эти серии 
изображений носят название стеков. Изображения, которые составляют 
стек, называют слоями. Все слои в стеке должны быть одинакового 
размера и одного и того же битового разряда. Перемещаться между 
слоями можно с помощью линейки прокрутки. Большинство фильтров 
программы ImageJ при использовании обрабатывают все слои в стеке. 

Выделения. Выделения – определяемые пользователем области 
или строки в пределах изображения. Одновременно быть активными 
несколько выделений не могут, поэтому если вы выделите одну часть, 
а затем вторую, то первое выделение пропадет и останется активным 
второе. Область выбора создается различными инструментами (прямо-
угольник, овал, многоугольник и «от руки» – область выделения вы вы-
бираете сами с помощью мыши). Выделенные области могут быть из-
мерены (Analyze → Measure), отфильтрованы, заполнены (Edit → Fill) 
или нарисованы (Edit → Draw). Выделенные строки создаются с помо-
щью линий (они могут быть прямые, сегментированные или «от руки»). 



61 

Чтобы нарисовать цветные линии, используется команда Edit → Draw. 
Длина выбранной линии может быть измерена с помощью команды 
Analyze → Measure. Выделенные участки могут быть отмечены кликом 
и перемещены. Строка состояния отображает координаты в верхнем ле-
вом углу выбранного участка (или ограничительного прямоугольника 
для непрямоугольных участков). Обратите внимание, что курсор изме-
няется на стрелку, когда он находится в пределах выбранного участка. 
Перемещение содержания выбранного выполняется с помощью команд 
Edit → Copy, Edit → Paste. 

Панель инструментов. Кнопки на панели инструментов позво-
ляют измерять различные объекты, наносить метки и другие эле-
менты на изображение и др. Клик правой клавишей мыши по некото-
рым кнопкам (с маленьким красным треугольником в правом нижнем 
углу) позволяет открыть меню с дополнительными инструментами. 

Инструменты выделения областей на изображении (Area 
Selection Tools). Первые четыре кнопки панели инструментов поз-
воляют выделить на изображении прямоугольную, овальную, мно-
гоугольную или произвольную область. Используя команды строки 
меню, выделенные области можно изменять, анализировать, копиро-
вать и др. При выделении области на изображении в строке состоя-
ния отображаются параметры данной операции, например коорди-
наты (xx, yy) области выделения на изображении. 

Инструмент Линия (Line Selection Tools). Данная кнопка поз-
воляет создать прямую, состоящую из сегментов, или произвольную 
линию (клик правой клавишей мыши позволяет выбрать необходи-
мую операцию). Информация о линии при ее создании изображается 
в строке состояния. Двойной клик левой клавишей мыши по кнопке 
Линия на панели инструментов позволяет вызвать меню для измене-
ния толщины линии. Измерить длину линии на изображении можно 
с помощью Analyse → Measure (или <Ctrl> + <M>). Чтобы сделать 
линию частью изображения, нарисуйте линию и используйте Edit → 
→ Draw (или <Ctrl> + <D>). 

Инструмент Угол (Angle Tool). Позволяет создать на изображе-
нии две пересекающиеся линии и измеряет угол между ними. 

Инструмент Точка (Point Tool). Используется для создания вы-
борки точек, подсчета объектов или записи координат пикселей. 
При установленном флажке Auto-Measure записывает координаты 
(X и Y) и цифровое значение яркости в диапазоне 0–255 в данной точке. 
Для цветных изображений будет указано среднее значение яркости 
красного, зеленого и синего каналов (Mean). 
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Инструмент Волшебная палочка (Wand Tool). При клике по ка-
кой-либо точке на изображении инструмент выделяет прилегающие 
области, значение цвета в которых совпадает с цветом точки или не-
значительно отличается от цвета точки. Изменить чувствительность 
можно в окне Tolerance (двойной клик по кнопке Волшебная палочка). 
Пункт Mode предлагает следующие варианты: 

1) Legacy – в этом случае Волшебная палочка выбирает только 
одну точку (пиксель), в который вы кликнули, и далее ищет пиксели 
с похожим цветом вокруг; 

2) 4-connected – в данном случае ImageJ учитывает, кроме пик-
селя, в который вы кликнули, также цвет четырех прилегающих с раз-
ных сторон пикселей и ищет пиксели с цветом, совпадающим с одним 
из рассматриваемых пяти пикселей; 

3) 8-connected – аналогично с 4-connected, но Волшебная палочка 
учитывает цвет не четырех, а восьми прилегающих пикселей. 

Инструмент Текст (Text Tool). Двойной клик по кнопке Текст 
откроет дополнительное окно, в котором можно установить тип, 
размер, написание шрифта. После щелчка по кнопке Текст кликните 
по изображению в необходимой для размещения текста точке, далее, 
удерживая левую клавишу мыши нажатой, создайте окно для ввода 
текста. Набирайте только английские буквы. Чтобы ввести греческую 
букву μ, нажмите кнопки <Alt> + <M>, а чтобы ввести значок анг-
стрема Å, нажмите <Alt> + <Shift> + <A>. Для изменения цвета шри-
фта используйте инструмент Пипетка. Вы можете свободно перетас-
кивать мышью поле с введенным текстом в необходимую точку 
изображения. Чтобы нанести текст в поле на изображение, восполь-
зуйтесь Edit → Draw (или <Ctrl> + <D>). 

Инструмент Лупа (Magnifying Glass). Позволяет увеличивать 
масштаб изображения при клике по нему левой клавишей и умень-
шать масштаб при клике по изображению правой клавишей мыши. 

Инструмент Перемещения (Scrolling Tool). Позволяет в случае, 
когда изображение превышает размер окна, в котором оно открыто, 
перемещать поле зрения на необходимый участок изображения. 
Инструмент можно активировать при выполнении любой операции, 
зажав клавишу пробел. 

Инструмент Пипетка (Color Picker). Позволяет установить ос-
новной цвет (Foreground color), в котором ImageJ будет наносить 
текст и другие элементы на изображении. Цвет можно выбрать либо 
при активированном инструменте Пипетка, кликнув на изображении 
по точке с интересующим цветом, в этом случае основным цветом 
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будет цвет точки, либо после двойного клика по кнопке Пипетка 
(или Image → Color → Color Picker) выбрать цвет из открывшейся 
палитры. Чтобы сменить цвет фона (Background color) на цвет точки 
изображения, при активном инструменте Пипетка кликните по необ-
ходимой точке на изображении с зажатой клавишей <Alt>. 

Команды меню Help. Меню содержит в основном команды от-
крытия некоторых страниц на официальном сайте программы ImageJ, 
команды настройки браузеров и некоторые другие команды: 

– ImageJ Website. Открывает главную страницу ImageJ в 
том браузере, который установлен у вас по умолчанию; 

– ImageJ News. Открывает страницу News официального сайта 
ImageJ; 

– Documentation. Открывает страницу Documentation на сайте ImageJ; 
– Installation. Открывает страницу с инструкциями по инсталля-

ции на сайте ImageJ; 
– Search Website. Открывает страницу поиска на сайте ImageJ. 

С помощью этой страницы можно производить поиск плагинов, мак-
росов или сообщений, которые были опубликованы в списке рас-
сылки ImageJ; 

– List Archives. Открывает страницу с архивами рассылки. На этой 
странице можно осуществлять поиск в архивах списка рассылки, от-
правлять сообщения в список, присоединиться или покинуть список; 

– Dev Resources. Открывает страницу с материалами для разра-
ботчиков на сайте ImageJ. На ней можно найти примеры и исходный 
код макросов или плагинов, готовые скрипты, описания работы мак-
роязыка; 

– Plugins. Открывает страницу плагинов на сайте ImageJ, 
где можно найти более 300 готовых плагинов, которые отсортиро-
ваны по функциям; 

– Macros. Открывает страницу макросов на сайте ImageJ, 
где можно найти более 200 готовых макросов; 

– Macro Functions. Открывает страницу руководства по макро-
языку на сайте ImageJ; 

– Update ImageJ. Обновляет ядро ImageJ (ij.jar). При запуске дан-
ной команды программа ImageJ предложит обновить ядро программы 
до последней версии путем скачивания обновленных файлов с сайта 
ImageJ и замены ими старых файлов на компьютере. Обратите вни-
мание, что если программа установлена в каталог Program Files, 
то учетная запись должна иметь права администратора, иначе файлы 
не смогут быть установлены в каталог программы; 
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– Update Menus. Обновляет меню ImageJ после добавления 
(или удаления) плагинов и макросов в папку плагинов. После выпол-
нения этой команды в меню Plugins все плагины и макросы будут 
стандартные, т. е. устанавливаемые автоматически при первой ин-
сталляции программы; 

– подменю About Plugins. Отображает информацию о некоторых 
плагинах, содержащихся в папке Plugins; 

– About ImageJ. Открывает изображение, содержащее инфор-
мацию о версии ImageJ и авторе, адрес сайта, Java-версию и ко-
личество доступной памяти. С помощью команды Plugins → 
→ Utilities → ImageJ Properties можно получить дополнительную ин-
формацию; 

– команды меню Window. Это меню состоит из четырех команд и 
списка открытых в ImageJ изображений. В списке всех изображений 
рядом с именем активного изображения стоит галочка; 

– Show All. Делает видимыми все окна, открытые ImageJ (не толь-
ко изображения, стеки, но и окна результатов, диалоговые окна раз-
личных настроек и т. д.); 

– Put Behind (Tab). Показывает следующее открытое изображе-
ние. Горячая клавиша данной команды <Tab>; 

– Cascade. Перемещает все открытые изображения в левую часть 
экрана и размещает их каскадами; 

– Tile. Уменьшает все изображения таким образом, чтобы они 
вошли на экран. 

Команды File. В File имеется вкладка New, которая содержит ко-
манды, позволяющие создавать новые окна. 

New → Image (<N> или <Ctrl> + <N>) открывает окно с новым 
изображением. При ее запуске появляется диалоговое окно, в кото-
ром можно задать необходимые параметры нового изображения (за-
головок изображения, тип, размеры и начальное содержимое). 

В диалоговом окне New Image в поле Name следует ввести 
название будущего изображения, в поле Type необходимо выбрать 
его тип (это могут быть 8-, 16- (беззнаковое), 32-битные полутоно-
вые (с плавающей точкой) изображения или цветные RGB-изобра-
жения). Поле Fill With (Заполнить) позволяет задать фон изображе-
ния – белый (white), черный (black) или переход от черного к белому 
справа налево (ramp). В полях Width и Height задается ширина 
и высота изображения в пикселях. Наконец, поле Slices (Слои) ука-
зывает, сколько слоев будет в изображении. Если установить в по- 
ле Slices значение больше единицы, то получится стек, с которым 
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программа ImageJ эффективно работает. При этом в окне нового 
изображения появится полоса прокрутки, которая будет служить 
для навигации между слоями стека. 

New → HyperStack создает новый гиперстек. При запуске ко-
манды появляется диалоговое окно, в котором задаются необходи-
мые параметры гиперстека. Часть из них рассмотрена ранее. 

Поскольку гиперстеки являются многомерными изображениями, 
их параметры расширяются до четырех (4D) или пяти (5D) измерений: 
x (ширина), y (высота), z (слои), c (цветовые каналы или длины волн) и 
t (временные кадры). Гиперстеки отображаются в окнах, содержащих 
три скроллера. Скроллер с названием c позволяет выбирать канал 
изображения, скроллер z – слой. Скроллер, обеспечивающий навига-
цию по кадрам (t), по аналогии с проигрывателем совмещен с кнопкой 
воспроизведения ►. При нажатии на нее можно просматривать изме-
нение гиперстека во времени. Если при создании гиперстека установ-
лен флажок Label Images, то на создаваемых изображениях гиперстека 
будет отображена информация о том, какой слой, канал или кадр перед 
вами. Пример гиперстека можно посмотреть, выбрав в меню File → 
→ Open Samples → Mitosis (26MB, 5D stack). 

New → Text Window (<Shift> + <N>) создает новое текстовое 
окно с названием «Untitled.txt».  

Текстовое окно представляет собой подобие блокнота, в кото-
ром можно набирать тексты, но самое главное, в нем можно писать 
и отлаживать макросы.  

New → Internal Clipboard (<Shift> + <V>) открывает содержимое 
так называемого внутреннего буфера обмена, т. е. буфера программы 
ImageJ. Например, если вы скопировали часть любого открытого изоб-
ражения, то при выполнении команды создастся новое изображение 
на основе скопированной части. 

New → System Clipboard (<Ctrl> + <Shift> + <V>). Программа 
ImageJ использует два буфера обмена: внутренний буфер программы 
и буфер обмена операционной системы.  

Команда New → System Clipboard открывает содержимое систем-
ного буфера как новое изображение. Для этого необходимо, чтобы в 
буфере находилось изображение либо его фрагмент. 

Команды File → Open, Open Next, Open Recent. Open – ко-
манда открытия файла (<О> или <Ctrl> + <O>). При вызове это-
го пункта меню открывается диалоговое окно, в котором нужно ука-
зать путь к файлу. Поддерживаются следующие форматы файлов: 
TIFF, GIF, JPEG, DICOM, BMP, PGM или FITS. 
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Изображения в формате TIFF могут быть 1-, 8-, 16- (беззнако-
выми), 32-битными (действительными) или RGB цветными. 

TIFF-файлы, содержащие множество изображений одинакового 
типа и размера, будут открываться в программе ImageJ как стек. Если 
установить опцию Debugging (Отладка) из меню Edit → Options → 
→ Misc, то ImageJ будет отображать теги файла TIFF при открытии 
такого файла. 

Поддержка технологии Drag and Drop для Windows позволяет 
пользователю открывать изображения, текстовые файлы, ROI (обла-
сти интересов) и LUT (Lookup table/Таблица поиска – «палитра» изу-
чаемого изображения) путем перетаскивания их прямо в окно ImageJ. 
Это существенно облегчает работу с программой ImageJ и избавляет 
от рутинного открытия файлов через File → Open. 

Open Next (<Ctrl> + <Shift> + <O>) открывает следующее изоб-
ражение из той папки, в которой было открыто активное изображе-
ние. Это бывает полезно, когда нужно последовательно работать с се-
рией изображений, которые пронумерованы и лежат в одной папке. 
Открывает примеры изображений, загружая их непосредственно с 
официального сайта ImageJ. Для этого, конечно, компьютер должен 
быть подключен к сети Internet. Предлагаемые примеры хорошо под-
ходят для тестирования плагинов и макросов и представляют собой 
различные типы изображений. 

Open Recent позволяет открыть одно из 15 последних недавно от-
крытых изображений. 

Команды File → Import. Import показывает установленные пла-
гины для захвата изображений. 

Image Sequence открывает серию изображений в указанной 
папке как стек. Все изображения должны быть одинакового раз-
мера и типа. Они могут быть в формате TIFF, JPEG, DICOM, BMP, 
GIF. Во время выполнения этой команды последовательно открыва-
ются два диалоговых окна. Первое окно служит для выбора папки. 
Здесь, чтобы открыть серию изображений, следует зайти в папку, в 
которой находятся необходимые изображения, выбрать одно из них 
и нажать кнопку Open (Открыть). После этого откроется второе 
диалоговое окно, в котором можно настроить параметры открывае-
мого стека. 

Поле Number of Images (Число изображений) предназначено 
для указания количества открываемых изображений. Starting Image 
устанавливает начальное изображение n в папке, с которого начнет 
открываться стек. Если изменить поле Increment (Прибавление) 
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до значения «2», то программа будет открывать изображения 
из папки через одно, т. е. каждое второе, значение «3» позволит от-
крывать каждое третье изображение в папке и т. п.  

Если в поле File Name Contains (Имя файла содержит) ввести 
строку, например ImageJ, то в стеке окажутся только те файлы, имена 
которых содержат эту строку. 

Если в поле Scale Image (Масштабировать изображение) умень-
шить значение, то это уменьшит и количество требуемой для работы 
памяти. Например, введение значения «50» в это поле уменьшает 
объем памяти, необходимый для открытия стека, на 75%.  

Если поставить флажок в поле Convert to RGB (Конвертировать 
в RGB), то это позволит совместить в открываемом файле как RGB, 
так и полутоновые изображения. 

При установке флажка Sort Names Numerically (Сортировать 
имена по номерам) открываемые в стеке файлы будут упорядо-
чены по номерам в именах файлов (например, name1.tif, name2.tif, 
name10.tif) вместо использования алфавитно-цифровой сортировки 
(например, name1.tif, name10.tif, name2.tif). Файлы формата DICOM 
серии (tag# 0020,0011) всегда сортируются по тегу номера изображе-
ния (0020,0011). 

Отметка Use Virtual Stack (Использовать виртуальный стек) ис-
пользуется для открытия изображений как виртуального стека, пред-
назначаемого только для просмотра. При создании такого стека он 
не будет записан на диск. Для примера использования виртуального 
стека нужно обратиться к макросу Process Virtual Stack, который рас-
полагается в папке с примерами. 

Другой способ открытия последовательности изображений – ис-
пользование макроса OpenSeriesUsingFilter, который открывает серию 
изображений в стек с помощью настраиваемых фильтров имен файлов. 

RAW импортирует изображения в формате RAW. Этот формат 
не имеет четкой спецификации и представляет информацию об изоб-
ражении в исходном, необработанном виде. Данная команда исполь-
зуется для импорта изображений, формат файлов которых непосред-
ственно не поддерживается ImageJ. При этом необходимо знать 
некоторую информацию о расположении файла с изображением, о 
размере изображения, а также о смещении начала изображения в 
файле, т. е. место, откуда начинаются данные в файле изображения. 

При выборе этой команды сначала откроется диалоговое окно, 
для того чтобы выбрать нужный для импорта файл, после чего откро-
ется второе диалоговое окно с параметрами импорта файла. 
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С помощью выпадающего меню в верхней части диалогового 
окна нужно выбрать тип изображения: 

1) 8-битное беззнаковое целое; 
2) 16-битное целое число; 
3) 16-битное беззнаковое целое; 
4) 32-битное целое число; 
5) 32-битное с плавающей точкой; 
6) 24-битное цветное RGB (перемежающееся); 
7) 24-битное цветное RGB (плоское); 
8) 32-битное цветное ARGB; 
9) 1-битная карта Bitmap, конвертированная в 8-битное изобра-

жение. 
Перемежающиеся (interleaved) RGB-изображения – это изобра-

жения, каждый пиксель в которых сохранен вслед за предыдущим в 
формате RGB. Плоские (planar) RGB-изображения содержат крас-
ный, зеленый и синий компоненты изображений, которые сохраня-
ются в отдельных 8-битных «плоскостях». ImageJ сохраняет RGB-
изображения (как TIFF, так и RAW) в формате interleaved. 

Image Width (Ширина изображения) – это количество пикселей в 
каждой строке данных изображения и Image Height (Высота изоб-
ражения) – количество строк в изображении. Offset to First Image 
(Смещение до первого изображения) – это количество байтов в файле 
до первого байта, принадлежащего собственно изображению. 

Number of Images (Количество изображений) определяет количе-
ство изображений, хранящихся в файле. Если установить это значение 
больше, чем фактическое число изображений, содержащихся в файле, 
то в результате получится стек, сокращенный до фактического размера. 

Gap Between Images (Интервал между изображениями) – коли-
чество байтов от конца одного изображения до начала следующего.  

Отметьте White is Zero (Белый равен нулю), если черные пиксели 
представлены значениями, которые меньше, чем значения яркости, 
используемые для белых пикселей. Если изображения выглядят как фо-
тонегативы, то изменение этого флажка должно решить проблему. 

Little-Endian Byte Order (Порядок байтов от младшего к стар-
шему) должен быть отмечен при импортировании 16- и 32-битных 
полутоновых изображений из машин с прямым порядком байтов, та-
ких как компьютер на базе Intel. 

Отметьте Open All Files in Folder (Открыть все файлы в папке), 
и ImageJ будет импортировать все изображения в папке в виде стека. 
Все изображения при этом должны быть одного размера и типа. 
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Установите флажок Use Virtual Stack (Использовать виртуаль-
ный стек), чтобы открыть 3D-изображения как виртуальный стек 
(только для чтения), что значительно сокращает необходимый объем 
памяти. 

Text Image (Текстовые изображения) открывает текстовый файл 
с разделителями-табуляторами как 32-битное изображение. Ширина 
и высота изображения определяется с помощью сканирования файла 
и подсчета числа слов и строк. Для текстовых файлов с целыми зна-
чениями, не превышающими 255, можно использовать Image → Type → 
→ 8-bit для преобразования в 8-битное изображение. Перед преобра-
зованием отключите Scale When Converting (Масштабировать 
при преобразовании) в меню Edit → Options → Conversions для предот-
вращения масштабирования изображения от 0 до 255. Для примера 
используйте макрос OpenTextImagesAsStack, который открывает по-
следовательность текста изображения в виде стека. 

Text File открывает текстовый файл. Также текстовые файлы могут 
быть открыты с помощью File → Open или обычным перетаскиванием 
файла прямо в рабочую область программы ImageJ. При этом в про-
грамме ImageJ откроется окно редактирования текста. Текстовый редак-
тор программы предназначен для редактирования и отладки скриптов 
и плагинов. Для этого в меню окна редактирования есть пункт Debug. 

Results импортирует таблицу Results с результатами ImageJ либо 
текстовый файл, содержащий таблицу с разделителями-запятыми. 

Stack From List открывает стек или виртуальный стек при по-
мощи текстового файла, в котором содержится список путей фай-
лов изображений. Сами файлы могут находиться в разных папках 
(в текстовом файле прописаны только пути), но все они должны 
быть одного размера и типа. Макрос Virtual Stack From List (файл 
VirtualStackFromList.txt) демонстрирует, как формировать список 
изображений и затем использовать его для открытия файлов изобра-
жений как виртуального стека. 

TIFF Virtual Stack импортирует файл TIFF как виртуальный стек. 
Команды меню File → Close, Close All, Save, Save As. Close 

(<Ctrl> + <W>) закрывает активное изображение. Если пользователь 
производил с изображением какие-либо действия и не сохранил их, 
то при выполнении данной команды будет предложено сохранить 
изменения.  

Close All закрывает все открытые окна. При выполнении данной 
команды будет предложено сохранить изменения или полученные 
результаты. 
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Save сохраняет активное изображение или стек в TIFF-формате. 
Для сохранения выделенной области служит дополнительная ко-
манда Image → Duplicate. 

Save As используется для того, чтобы сохранить активное окно в 
необходимый формат изображений, справочную таблицу, результат 
измерения или координаты. 

TIFF сохраняет активное изображение или стек в TIFF-формате. 
Этот формат (кроме RAW) поддерживает все типы данных ImageJ 
(8, 16, 32 бит с плавающей точкой и RGB). 

GIF сохраняет активное изображение в формате GIF. RGB-изо-
бражения перед сохранением должны быть преобразованы в 8-бит-
ные изображения при помощи команды Image → Type → 8-bit Color. 
В противном случае сохранение невозможно и будет появляться 
ошибка с предложением конвертировать в 8-bit Color. 

Стеки при помощи этой команды преобразуются в анимирован-
ные GIF. Для того чтобы установить скорость кадров, нужно исполь-
зовать Image → Stacks → Tools → Animation Options. 

JPEG сохраняет активное изображение в формате JPEG. Можно 
установить качество JPEG (JPEG Quality) в меню Edit → Options → 
→ Input/Output для определения уровня компрессии JPEG (0–100). 
Меньшее значение этого показателя создает меньшие по размеру 
файлы, при этом файлы имеют низкое качество. Большие значения 
создают большие по размеру файлы с более высоким качеством. 

По умолчанию разрешение, записываемое в заголовке файла JPEG, 
установлено в размере 72 dpi. При сохранении в формате JPEG изоб-
ражение может сохраняться с потерями качества и образованием не-
значительных артефактов. Не рекомендуется использовать сохране-
ние в формате JPEG, если планируется в дальнейшем проводить 
измерения на этом изображении или работать с ним. 

ZIP сохраняет активное изображение или стек в файл TIFF-фор-
мата и упаковывает его в архив ZIP. 

Raw Data сохраняет активное изображение или стек как построч-
ные данные о пикселях без раздела заголовка. 

Text Image сохраняет активное изображение как текстовый файл, со-
держащий таблицу с числовыми данными, разделенными табуляциями. 

Image Sequence сохраняет все слои открытого стека как отдель-
ные файлы в формате TIFF, GIF, JPEG или RAW. 

AVI сохраняет активный стек в видеофайл формата AVI, исполь-
зуя частоту кадров, которая задается в диалоговом окне Image → 
→ Stacks → Tools → Animation Options. 
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PNG сохраняет активное изображение в PNG-формате (Portable 
Network Graphics). Все типы изображений, кроме RGB, хранятся в 
виде 8-битных PNG. Для таких 8-битных изображений может быть 
задан прозрачный цвет в диапазоне от 0 до 255, значение которого 
устанавливается при помощи команд Edit → Options → Input/Output. 

LUT сохраняет таблицу преобразования (LUT) активного изобра-
жения в файл. Размер такого файла 768 байт, из которых 256 байт 
красных, 256 байт зеленых и 256 байт синих градаций яркости. 

Measurements. Таблица активного окна Results сохраняется в тек-
стовый файл с числовыми значениями, разделенными табуляцией. 

Selection сохраняет выделенную область на изображении в файл. 
Для восстановления выделения нужно открыть файл с сохраненным 
выделением с помощью команды File → Open. 

XY Coordinates сохраняет XY координаты линии выделения 
или границы области выделения в текстовый файл, содержащий две 
колонки с координатами точек, разделенных табуляцией. Коорди-
наты прямоугольного, овального выделения и выделения прямой ли-
нии не могут быть сохранены в такой файл. 

Команды File → Revert, Page Setup, Print, Quit. Revert заменяет 
активное изображение его последней сохраненной версией. Это дей-
ствие соответствует закрытию окна без сохранения и его повторному 
запуску. 

Page Setup запускает диалоговое окно, в котором можно контро-
лировать параметры страницы и изображения перед отправлением ее 
на печать. Здесь можно уменьшить размеры изображения. Для этого 
следует изменить масштаб в процентах настолько, насколько это не-
обходимо.  

При установке флажка в поле Draw Border (Печатать границу) 
изображение будет иметь по краям линию в один пиксель. 

Установка флажка Center on Page (Центр страницы) позволяет 
напечатать изображение в центре страницы, а не в левом верхнем 
углу (при отсутствии галочки). 

Print Title распечатает заголовок изображения вместе с самим 
изображением. 

Selection Only позволяет распечатать только выделенную область. 
Галочка в поле Rotate 90° разворачивает рисунок на 90° влево пе-

ред тем, как напечатать его. 
Команда Print отправляет на печать активное изображение. Обы-

чно размер печатного изображения чуть меньше размера картинки 
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на экране. Для коррекции параметров печати пользуйтесь диалого-
вым окном Page Setup. 

Quit завершает работу программы ImageJ. Если остались не сохра-
ненные изображения, то будет предложено сохранить их. Также можно 
выйти из программы, нажав на кнопку Закрыть в заголовке ImageJ. 

Наиболее важные опции. Команды Process → Filters. Gaussian 
Blur – это фильтр для сглаживания изображения, построенный на ос-
нове функции Гаусса для сглаживания. При запуске появляется диало-
говое окно, в котором задается Sigma – значение сглаживания (рис. 33). 

 

 
а 

      
б                                              в 

Рис. 33. Диалоговое окно (а) и пример работы Gaussian Blur (б, в) 
 
Median уменьшает шум в активном изображении, заменяя каж-

дый пиксель медианным значением соседних пикселей. Размер окрест-
ности пикселей, с которых будет считываться медианное значение, 
определяется путем ввода ее радиуса в диалоговом окне. 

Mean сглаживает изображение, заменяя каждый пиксель средним 
значением соседних пикселей. Размер окрестности пикселей, с кото-
рых будет считываться среднее значение, определяется путем ввода 
ее радиуса в диалоговом окне. 

Minimum заменяет каждый пиксель изображения на пиксель се-
рого цвета, имеющий наименьшее значение в данной окрестности. 
Окрестность в этом случае также задается вручную в диалоговом 
окне, которое появляется при запуске команды. 

Maximum заменяет все пиксели в окрестности на пиксель, кото-
рый имеет наибольшее значение в данной окрестности. 
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Variance – это фильтр для выделения внутренних и внешних 
краев изображения. 

Команды Process → Image Calculator, Subtract Background. 
Image Calculator выполняет арифметические и логические опера-
ции между двумя изображениями. При работе со стеками оба стека 
должны иметь одинаковое количество слайдов. Image1 и Image2 
должны быть изображениями одного типа, желательно одинакового 
размера. В диалоговом окне, которое появляется при выполнении ко-
манды, можно выбрать один из 12 операторов, по типу которого бу-
дет выполняться операция между изображениями (рис. 34). 

 

 
Рис. 34. Диалоговое окно Image Calculator 

 
Subtract Background удаляет гладкий непрерывный фон из изобра-

жений. Действие данного фильтра основывается на алгоритме rolling 
ball (крутящийся шар). Это выглядит как шар с заданным радиусом, 
который катится по задней поверхности изображения и создает фон. 
В настоящее время в ImageJ используется алгоритм вращающегося 
параболоида. При запуске появляется диалоговое окно (рис. 35). 

 

 
Рис. 35. Диалоговое окно Subtract Background 
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Результаты работы фильтра Subtract Background представлены 
на рис. 36. 

 

 
Рис. 36. Примеры работы фильтра Subtract Background 

 
Команды Analyze → Measure, Analyze Particles, Clear Results, 

Set Measurements, Set Scale. Перед работой с этой вкладкой следует 
подумать, что вы собираетесь измерять. Для этого необходимо вы-
звать вкладку Set Measurements (Задать измерения). При запуске 
этой команды появляется диалоговое окно, которое позволяет задать 
те параметры, которые необходимо анализировать в меню Analyze → 
→ Measure и Analyze → Analyze Particles (рис. 37). 

 

 
Рис. 37. Диалоговое окно Set Measurements 

Light Background Separate Colors Create Background 

Sliding Paraboloid Disable Smoothing 
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Наиболее полезные параметры приведены ниже. Area (Площадь) – 
площадь выделения (если его нет, то площадь всего изображения) – 
подсчитывается в квадратных пикселях. Можно изменить параметры 
измерения, например, на квадратные миллиметры. Для этого исполь-
зуется команда Analyze → Set Scale. 

Mean Gray Value устанавливает усредненное серое значение внутри 
выделения. Это усреднение складывается из суммы всех серых пикселей, 
поделенных на общее количество пикселей на изображении. Можно са-
мим установить калибровочные значения в меню Analyze → Calibrate. 

Для изображений в формате RGB усредненное серое значение 
рассчитывается по формуле 

 .
3

R G BV + +=  (8) 

Standard Deviation – стандартное отклонение от усредненного 
серого значения, которое используется при создании этого самого се-
рого значения. 

Modal Gray Value – наиболее часто встречающиеся значения се-
рого в данном выделении. В гистограмме такого выделения указан-
ное значение будет обладать наивысшим пиком. 

Min & Max Gray Level – минимальное и максимальное значения 
серого в данном выделении. 

Centroid – центральная точка активного выделения. Она формиру-
ется на основе всех значений X и Y координат в активном выделении. 

Center of Mass – это усредненное значение всех значений X и Y 
координат в активном выделении по яркости.  

Perimeter – периметр (длина внешней границы всего выделения). 
Integrated Density – сумма значений пикселей на изображении 

или выделении. С математической точки зрения это произведение 
Area (Площадь) и Mean Gray Value (Усредненное серое). 

Median – срединное значение пикселей на изображении или вы-
делении. 

Area Fraction – доля пикселей на изображении или выделении, 
которые были выделены красным цветом при помощи команды 
Image → Adjust → Threshold. Если эта команда не была выполнена, 
то данная опция подсчитывает количество ненулевых пикселей. 

Limit to Threshold (Ограничение порога). При включении данной 
опции в измерение входит только та часть изображения, которая вклю-
чена в область выделения порогом. Для установления данной границы 
используется команда Image → Adjust → Threshold. 
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Measure (Измерение) (<Ctrl> + <M>). В зависимости от того, ка-
кие параметры выбраны в меню Measure → Set Measurements, данная 
команда вычисляет и отображает в специальном окне Results стати-
стические данные об изображении (рис. 38). 

 

 
Рис. 38. Примеры работы команды Measure 

 
Analyze Particles (Анализ частиц). Эта команда измеряет какую-

либо часть изображения или порог. Работает по принципу сканиро-
вания всего изображения или выделения, пока не находит края объ-
екта. После этого выделенный объект описывается с помощью ин-
струмента Wand Tool (Волшебная палочка), измеряется командой 
Measure, заполняет его, чтобы сделать невидимым, и продолжает ска-
нирование, пока не достигнет конца изображения или выделения. 
Чтобы остановить процесс, используется команда ESC.  

Для более четкого выделения порога применяется команда Image → 
→ Adjust → Threshold. Для работы с RGB-изображениями они должны 
быть предварительно конвертированы командами Image → Adjust → 
→ Color Threshold или Process → Binary → Make Binary. В противном 
случае появится сообщение об ошибке. Если эти условия соблюдены, 
то откроется диалоговое окно для настройки Analyze Particles (рис. 39). 

 

 
Рис. 39. Диалоговое окно  

настройки Analyze Particles 
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Рис. 40. Результаты работы Analyze Particles с различными параметрами  
 
На рис. 40 продемонстрированы результаты работы анализа частей. 
Команды Analyze → Histogram, Plot Profile. Histogram (Гисто-

грамма) (<Ctrl> + <H>) вычисляет и отображает гистограмму рас-
пределения серых значений на активном изображении или выделе-
нии (рис. 41). 

 

 
Рис. 41. Гистограмма изображения 

 
Также при выполнении данной команды рассчитывается общее 

количество пикселей, среднее, минимальное и максимальное значе-
ния, стандартное отклонение и некоторые другие значения. Данную 
гистограмму можно копировать в буфер обмена (Copy) или отобра-
зить в отдельном окне при помощи команды List. 

Plot Profile (График профиля) (<Ctrl> + <K>) отображает в дву-
мерной графике интенсивность распределения пикселей на выде-
лении (рис. 42). 

«Outlines» «Masks» «Ellipses» Original Image Thresholded 
using 
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Рис. 42. График профиля 

 
Surface Plot (График поверхности) отображает трехмерный гра-

фик интенсивности распределения пикселей на активном выделе-
нии. Работает с черно-белыми изображениями (8-, 16-, 32-битными) 
или псевдоцветными изображениями. В противном случае будет по-
являться сообщение об ошибке с указанием о необходимости ввести 
соответствующие изменения. 

Команды Analyze → Tools → Fractal Box Count (расчет фрак-
тальной размерности). Показывают число областей увеличивающе-
гося размера, необходимых для вписания в них бинарных объектов 
изображения (рис. 43). 

 

 
Рис. 43. График анализа размеров областей и их числа,  
необходимого для вписания всех бинарных объектов 

 
Редактирование и анализ изображений с помощью ImageJ. 

Отмена предыдущего действия (Undo). Edit → Undo отменяет 
предыдущее действие. Возможна отмена только одного действия. 

File → Revert (Вернуть) отменяет все выполненные манипу-
ляции и переводит изображение в исходный после открытия вид. 
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Выделив часть изображения с помощью прямоугольного выде-
ления командой Image → Crop (Обрезка), можно обрезать не входя-
щие в выделение участки. После выделения участка на изображении 
команда Edit → Clear Outside (Очистить снаружи) очистит все 
участки, не попавшие в зону выделения. Команда Edit → Clear очи-
стит участки внутри выделенной области.  

Ниже приведен пример выполнения задания по коррекции фона 
изображения. 

Откройте изображение и обратите внимание, что нижняя часть 
изображения намного темнее, хотя окрашивание выглядит однород-
ным, что указывает на неравномерное освещение (рис. 44). 

 

     
 а б     в 

Рис. 44. Открытое изображение: 
а – исходное изображение; б – перевод изображения в красный канал; 

в – вкладка для перевода изображения в красный канал 
 
Выберите изображение красного канала и перейдите в меню 

Process → Filters → Gaussian Blur. Используйте Sigma (Radius), чтобы 
создать изображение для вычитания. Включите предварительный 
просмотр, чтобы проверить эффект на изображении, прежде чем на-
жать кнопку <OK> (рис. 45). 

 

 
Рис. 45. Диалоговое окно Gaussian Blur 
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Перейдите в меню Process → Image Calculator. Выберите изоб-
ражение зеленого канала (Example.tif (green)) для изображения 1 
и размытое изображение красного канала (фон) (Example.tif (red)) 
для изображения 2. Используйте операцию Divide и другие пара-
метры, как указано на рис. 46. 

 

 
Рис. 46. Диалоговое окно Image Calculator 

 
Исходное изображение зеленого канала и обработанное изобра-

жение с LUT представлены на рис. 47. 
 

   
а      б 

Рис. 47. Исходное (а) и обработанное (б) изображение зеленого канала с LUT 
 
Примените Green LUT к обработанному изображению, выбрав 

Image → LookUp Tables → Green. Измените тип изображения обратно 
на RGB Color, перейдя в Image → Type → RGB Color (рис. 48). 
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а      б 

Рис. 48. Исходное (а) и обработанное (б) изображение в исходном цвете RGB 
 
Фон исчез, так что изображение выглядит более четким. Обра-

тите внимание, что, если вы собираетесь анализировать изображе-
ние, например, на предмет интенсивности, вам следует получить фо-
новое изображение с теми же настройками, что и ваше реальное 
изображение, и использовать его для процесса коррекции для каж-
дого изображения. 
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ГЛАВА 8 

СРАВНИТЕЛЬНАЯ ОЦЕНКА МИКРОСТРУКТУРЫ  
ВОЛОКНИСТОГО КОМПОЗИЦИОННОГО МАТЕРИАЛА  

С ПОМОЩЬЮ ЦИФРОВЫХ ТЕХНОЛОГИЙ 

Разработка альтернативных методов, позволяющих оценивать 
качество волокнистого композиционного материала, в частности бу-
маги и картона, в современных условиях является актуальной зада-
чей, которая решает проблему ограниченного доступа к научным 
лабораториям. Заменить частично сложное дорогостоящее оборудо-
вание можно путем применения новых цифровых технологий. Клю-
чом к цифровизации исследований свойств бумаги и картона является 
изучение их микроструктуры с помощью современных технологий. 

Специфика микроструктуры позволяет определить ряд показате-
лей. С помощью цифровой обработки изображений микроструктуры, 
полученных электронным микроскопом, можно оценить некоторые 
физико-механические свойства бумаги и картона, равномерность 
формования и распределения крахмала, пористость. Основным ин-
струментом цифровой обработки микроструктуры бумаги и картона 
является программа ImageJ. Целый ряд физико-механических пока-
зателей можно оценить, исследовав микроструктуру поперечного 
среза бумаги и картона, выполненного с помощью современных ме-
тодов подготовки образцов для электронной микроскопии. Проведен-
ные ранее исследования показали, что микроструктура бумаги и кар-
тона во многом определяет физико-механические свойства.  

При цифровой обработке микроструктуры волокнистого ком-
позиционного материала важную роль играет выбор программы 
для оценки изображения. 

Программа и ее функционал определяют качество и время из-
мерений. 

Принципиально важно, в каком формате изображение микрострук-
туры обрабатывается. Векторный формат работы с файлом (программы 
AutoCAD, CorelDRAW и т. д.) позволяет оценить с высокой точностью 
площадь, периметр объектов, но для их формирования понадобится 
ручная обводка контуров, что требует больших затрат времени. Растро-
вый формат работы с файлом (программы Adobe Photoshop, ImageJ, 
IP SQUARE и т. д.) позволяет автоматизировать и ускорить процесс 
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обработки, но программы определяют размеры, рассчитывая количе-
ство пикселей того оттенка цвета, которому соответствует исследуе-
мая область. Точность оценки в программе растровой обработки 
файла будет ниже, если кроме исследуемой области будут захвачены 
области с идентичным оттенком цвета. 

Поэтому сравнительная оценка микроструктуры волокнистого 
композиционного материала с помощью современных цифровых тех-
нологий представляется важным и актуальным направлением, кото-
рое позволит разработать высокоточный экспресс-метод оценки по-
казателей бумаги и картона, что является базой для создания прибора 
для контроля качества бумаги и картона на предприятиях. 

Для оценки равномерности распределения срезов волокон были 
использованы программы АutoCAD, ImageJ, Excel, с помощью ко-
торых установлены площади среза материала. 

По результатам сканирующей электронной микроскопии, осна-
щенной современным оборудованием для подготовки проб, включа-
ющим ионную резку материала, было получено изображение попе-
речного среза (рис. 49). 

 

 
Рис. 49. Изображение поперечного среза  

двухслойного волокнистого композиционного материала 
 
В программе AutoCAD была выделена 51 область среза волок-

нистого материала, для каждой из которых определена площадь 
(рис. 49). Погрешность измерения при оценке площади в программе 
AutoCAD (векторный формат файла) связана с ошибками нанесения 
линии вдоль контура среза волокнистого материала, которая не пре-
вышает 1%. Недостатком метода является длительность ручной об-
водки областей среза волокон, а достоинством – высокая точность.  

При оценке площади срезанных областей в растровых форматах 
программы определяют области с одинаковыми оттенками цветов и 
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предоставляют значение площади по количеству пикселей, соответ-
ствующих определенному цвету. При этом может быть выделена об-
ласть волокнистого материала, которая не находится в плоскости 
среза. Например, на представленном ранее изображении поперечного 
среза волокнистого материала области нижней и верхней поверхно-
стей материала в некоторых местах имеют практически одинаковый 
оттенок с областью среза волокон, находящейся вне плоскости среза. 
Программ, работающих в растровом формате, много, но наиболее по-
пулярной и адаптированной под анализ микроскопических исследо-
ваний является ImageJ. 

Для оценки площади областей среза волокон с помощью программы 
ImageJ необходимо перевести существующий файл в формат «8-bit» 
(рис. 50), который позволит сократить количество цветовых оттенков. 

 

 
Рис. 50. Работа в программе ImageJ: перевод изображения  
поперечного среза волокнистого материала в формат «8-bit» 

 
На следующем этапе в программе ImageJ осуществляется на-

стройка контрастности изображения командой Threshold. Выбор кон-
трастности имеет важное значение для точности получаемых значений 
площадей областей среза в растровом формате работы с изображением. 
Автоматически преобразованная контрастность снимка микрострук-
туры поперечного среза в ImageJ связана с большой погрешностью, 
при этом диапазон оттенков находится в пределах от 98 до 255 (рис. 51). 
Рассчитанная программой площадь отличается от площади, установ-
ленной в векторном формате, более чем на 50%. 
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Рис. 51. Результат выделения областей среза 

в программе ImageJ в режиме Auto 
 
Поэтому для дальнейших исследований необходимо подобрать 

контрастность таким образом, чтобы она максимально была при-
ближена по площади областей среза волокон, установленной при ра-
боте с изображением в векторном формате. В некоторых случаях 
область среза может быть выделена отдельно, чтобы нижняя и верх-
няя поверхность не создавали дополнительную погрешность в изме-
рении. Для этого существует два способа: во-первых, можно полу-
чить два снимка поперечного среза под небольшими углами в 
несколько градусов, чтобы была видна в одном случае только верх-
няя поверхность, в другом случае – только нижняя. Затем соединив 
два снимка, можно добиться удаления областей, соответствующих 
поверхности бумаги (рис. 52). Во-вторых, можно удалить область 
в программе ImageJ.  

 

 
Рис. 52. Выделение области поперечного среза волокнистого 

композиционного материала 
 

Важным этапом обработки изображения поперечного среза во-
локнистого композиционного материала в программе ImageJ явля-
ется ручная настройка контрастности изображения. 
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После «бинаризации» этого изображения рассчитывается пло-
щадь среза, которая соответствует области черного цвета. В дан-
ном случае площадь среза, полученная при расчете в программе 
растрового формата работы с изображением, составила 6178 мкм2, 
что на 22,5% больше значения, полученного при обработке изобра-
жения в векторном формате изображения. Большая погрешность свя-
зана с тем, что при расчете программа, работающая с растровым фор-
матом изображения, учитывает также области, которые не находятся 
в плоскости среза, но имеют идентичный цветовой оттенок. Это «про-
блемные участки», которых немного, но они так же, как и в случае 
с поверхностью, требуют ручного исключения. 

Программа ImageJ позволяет выделить «проблемные области» 
и удалить их. После удаления «проблемных участков» вновь рас-
считывается площадь области, закрашенной черным цветом. Если 
расчет ведется в другой программе, например IP SQUARE, то необ-
ходимо использовать элемент с заведомо известной площадью.  

Данные по поверхности среза волокон, полученные с помощью 
программы, работающей в растровом формате, сопоставляются с дан-
ными, полученными в векторном формате работы (таблица). 

 
Данные расчета поверхности среза волокнистого композиционного  

материала, полученные с помощью программ, работающих в векторном  
и растровом форматах файлов 

№ п/п 
Этапы расчета площадей среза  

волокнистого композиционного  
материала в поперечном срезе 

Площадь, 
мкм2 

Погрешность, 
% 

1 Параметр Treshold в режиме Auto 98, 255 
(ImageJ) 

17 287 72,3 

2 Параметр Treshold в режиме Auto 98, 255 
(удаление областей, соответствующих 
поверхности волокнистого материала) 
(ImageJ) 

12 657 62,1 

3 Параметр Treshold 120, 240 (после «бина-
ризации» изображения) (ImageJ) 

6178 22,5 

4 Параметр Treshold 120, 240 (после «бина-
ризации» изображения и удаления «про-
блемных участков» в микроструктуре по-
перечного среза) (ImageJ, IP SQUARE)  

4771 0,5 

5 Общая площадь среза волокон, установ-
ленная при работе в векторном формате 
файла (с помощью программы AutoCAD) 

4791 0 
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Из таблицы видно, что при ручной установке оттенка цветов в пре-
делах 120 и 240 погрешность измерения площади среза волокнистого 
материала снизилась с 62,1 до 22,5%, хотя это также много. Удаление 
«проблемных участков» позволило приблизить площадь среза к той, 
которая была установлена при обработке изображения с помощью 
программы, работающей в векторном формате. По установленным 
значениям оттенков цветов (120, 240) можно осуществлять измере-
ния других снимков поперечных срезов (или поперечного среза с 
большой протяженностью) при условии, если электронная микро-
скопия осуществлялась в одинаковых условиях (тот же угол, под ко-
торым делался снимок, то же освещение, оборудование для подго-
товки образцов). 

Таким образом, комбинация двух принципов обработки изобра-
жений поперечного среза волокнистого композиционного материала 
(работа с векторным и растровым форматами изображения) позво-
ляет повысить точность измерения и сократить временные затраты. 
Приведенные в таблице пункты 1–5 являются этапами обработки сре-
зов волокон. Их последовательность представляет собой краткое 
описание метода, сущность которого заключается в комбинации ис-
пользования программ векторного и растрового форматов работы с 
изображением микроструктуры волокнистого материала.  
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